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Introduction

Introduction

The examples in this manual can be made in a full licensed as well as in a tryout or student version of
SCIA Engineer.

Here follows an overview of the required SCIA Engineer modules / editions, per subject:
- Theoretical reinforcement design
esacd.02 (2D members) Concept edition

- Practical reinforcement design
esacdt.03 (2D members) Concept edition




Reinforced concrete (EN 1992) — 2D members

Plate design

Model

1 _Input of geometry

Project data: 2D environment = Plate XY

Project data ﬁ
Basic data |.Functionahty-ii Loads i|-F’rm.et:ticn-§

Data Material
MName |Example project Corcrale =

L Material C20/25 .

, - Reinforcement mat.. B 500A v|
Part: EACT Reinforced Concrete Steel (]

Timber m}

T Other ]
Besciption e cesir Aluminium u]
Author: ESc“i.a.Eng.\.nE!er
Date: [27.07.2011

Code
Structure: National Code
[Plate xv [v] Bl [=cen )
Project Level Model: National annex:
[Advanced [¥] [ore ] Ea [ECEN el
[ 0K I [ Cancel ]

The Reinforcement material (e.g. B500A) chosen in the Project data window, will define the steel
quality used for the theoretical reinforcement design.
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Plate design

Properties of the slab and the line supports:

(12D member
Name Slabl id\
Type plate (30) Em
Analysis model Standard |
Shape i |
,T - —ja Material £25/30 a1 |
- 1 T FEM model Isatropic _:“ A
___ __ __ | FEMnonlinear model none L“ 3
ez ~ // Thickness type constant A:“
e // Thickness [mm] 250 |
SiESS LCS Type Standard A:J!
LCS Angle [deg] 0,00 =
Layer Laagl
z Nodes
‘/ y Table edit geometry . ]|
[ Line support on 2D member edge ﬁ
Name Sle
Z Rigid =i
Rx Free =
Ry Free | =
=[G y |
System GCS j
Position x1 0.000
Position x2 1.000
Coord. definition Rela j
Crigin From start j
L4
2 Loads
Load cases & Load groups
Load Case Action type Load Group Relation EC1-Load type
Self weight Permanent LG1 / /
Walls Permanent LG1 / /
Service load Variable LG2 Standard Cat B: Offices
[J'Load cases ﬁ
AR eBEE- 9¢ & SH |a [v]
LC1 - Self weight JLc
LC2 - Wals Description Selfweight
LC3 - Sevice load Action type Permanent |~
LoadGroup LGT ...
Load type Selfweight hd
Direction Z |~
[ New ][ Insert ][ Edit ][ Delete ]
(] Load groups ﬁ
ARemk o & 3H | [v]
LGl |LG2
LG2 | Relation Standard E
Load Variable =i
EC1-load type CatB : Offices |~




Reinforced concrete (EN 1992) — 2D members

Load combinations

Type EN-ULS (STR/GEOQO) Set B
Type EN-SLS Quasi Permanent

[ combinations ﬁ
L 1] & | Input combinations -
uLs [ JuLs
5LS Ciescription
Type EN-ULS (STR/GEO) SetB j
B Contents of combination
LC1 - Selfweight [-] 1.00
LC2Z - Walls [-] 1.00
LC3 - Sevice load [] 1.00
Explode to envelopes =
Explode to linear =
[ New ][ Insert ][ Edit ][ Delete ]

Result classes

All ULS+SLS
] Result classes ﬁ
A BB 9 & A >
AlULS+SLS | AllULS+5LS
Description
B List
[ MNew ][ Insert ][ Edit ][ Delete

3_Finite element mesh
Introduction

2 types of finite elements are implemented in SCIA Engineer:

- The Mindlin element including shear force deformation, which is the standard in SCIA Engineer. The
Mindlin theory is valid for the calculation of both thin and thick plates.

- The Kirchhoff element without shear force deformation, which can be used to calculate and design
only thin plates.

The element type used for the current calculation is defined in the Setup menu > Solver:

[Jsolver setup ﬁ
Name
B Solver
Advanced solver options O
MNeglect shezirforce deforma_tion ( Ay, Az >=A) O
I Bending theory of plate/shell analysis Mindlin -
Type of solver Direct Jid
MNumber of thicknesses of rib plate 20
Number of sections on average member 10
Maximal acceptable translation [mm] 1000.0
Maximal acceptable rotation [mrad] 100.0
Coefficient for reinforcement 1
& ﬂ y OK. | Cancel




Plate design

Mesh

generation

Via the Main menu > Calculation, mesh > Mesh generation, or ‘Project’ toolbar

Graphical display of the mesh

Set view parameters for all, via right mouse click in screen or Command line toolbar
- Structure tab > Mesh > Draw mesh
- Labels tab > Mesh > Display label

Mesh

Via the Main menu > Calculation, mesh > Mesh setup, or Setup menu > Mesh

refinement

Average size of 2D (mesh) elements is by default = 1m.

] Mesh setup

X

B Mesh S
Minimal distance between two points [m] 0.001
Average number of tiles of 10 element 1
Awverage size of 2D element/curved element [m] 1.000
B/ 1D elements
Minimal length of beam element [m] 0100
taximal length of beam element [m] 100,000 =
Awerage size of cablas, tendons, elements on subsoil, nonlinear soil ... 1,000
Generation of nodes in connections of beam elements =]
Generation of nodes under concentrated loads on beam elements m]
Generation of eccentric elements on members with variable height m]
Mao. of FE per haunch 5 L
Apply the nodal refinement Mo members j
B 2D elements
To generate predefined mesh |z} [ |
@ ﬂ ﬂ oK | Cancel |

‘Basic rule’ for the size of 2D mesh elements: take 1 to 2 times the thickness of the plates in the
project. For this example, take a mesh size of 0,25 m.
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Reinforced concrete (EN 1992) — 2D members

4 Results for the linear calculation
Specification of results

After running the linear calculation, go to the Main menu > Results > Member 2D - Internal Forces.
Specify the desired result in the Properties menu:

Properties x|
|2D element - Interne krachten (1) j AV
| Results
Selection All | <=
Type of loads Combinations |~
Combinations ULS =i
Filter Mo |~
System Local =i
Rotation [deg] 0.00
Averaging of peak [m]
Location In nodes, avg. on macro =i
Type forces Basic magnitudes =i
Envelope Minimum |~
Drawing Standard =i
Values mx A
Extreme Global =i
Drawing setup =
Refresh P
Detailed results in mesh node b
Preview P
-System

Local: according to the local axes of the individual mesh elements
LCS-Member 2D: according to the LCS of the 2D member

-Location: 4 different ways to ask for the results, see Annex 2
-Type forces: Basic, Principal or Design magnitudes, see Annex 1

-Drawing setup: Click on the button El Here you can modify the display of 2D results (Isobands /
Isolines / Numerical results / ...), modify the minimum and maximum settings, ...

After making changes in the Properties menu, you always have to execute the ‘Refresh’ action.
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Plate design

Types of results

Basic magnitudes
Combination = ULS; Type forces = Basic magnitudes; Envelope = Minimum; Values = mx

mx-min [kNm/m]
39.56
0.00

\ -20.00
‘ ‘ ‘ -40.00
T L] o
\ /“ [ -£0.00
-100.00
| -120.00
l\‘ Opening! e

| ﬂ XAy

- N

LT

Design magnitudes
Combination = ULS; Type forces = Design magnitudes; Envelope = Maximum; Values = mxD+

mxD+-max [kNm/m]
17068
140.00
120.00
100.00
80.00
L §
/" 60.00
T 40.00
b
] 20.00
0.00

Openingl d

\\" P [
\‘i !

The available values are mxD, myD and mcD, where ‘D’ stands for design. The ‘+" and ‘-* respectively
stand for the values at the positive and negative side of the local z axis of the 2D member.

So for instance the value mxD+ is the moment that will be used for the design of the upper
reinforcement in the local x-direction of the 2D member.

The calculation of design moments for plates and shells according to the EC2 algorithm follows the
chart from CSN P ENV 1992-1-1, Annex 2, paragraph A2.8.

The calculation of design forces for walls according to the EC2 algorithm follows the chart from CSN P
ENV 1992-1-1, Annex 2, paragraph A2.9.

An overview can be found in SCIA Engineer’s Help menu > Contents > Reference guide.

11



Reinforced concrete (EN 1992) — 2D members

What happens, is that for the 3 characteristic (bending and torsion) moments an equivalent set of 3
design moments is calculated:

mx mxD
my = myD
mxy mcD

It is clear that mxD and myD are the moments to be used for the reinforcement design in the respective
direction. The quantity mcD is the design moment that has to be taken by the concrete. The Eurocode
does not mention any check for this value, but it is however available in SCIA Engineer for the reason
of completeness.

Analogously, if membrane effects are present, for the 3 characteristic membrane forces an equivalent
set of 3 design forces is calculated:

nx nxD
ny = nyD
nxy ncD

Here, the quantity ncD does have a clear meaning: it is the compression force that has to be taken by
the concrete compression struts. Therefore, to make sure that concrete crushing will not occur, the
value ncD should be checked to be < fcd.

Attention : These design magnitudes are not the ones used by SCIA Engineer for the reinforcement
design in the Concrete menu. A much more refined transformation procedure is implemented there to
calculate the design magnitudes from the basic magnitudes.

Principal magnitudes

Results menu > Member 2D — Stresses

Combination = ULS; Type forces = Principal magnitudes; Envelope = Maximum; Values = sigl1+
Drawing = Trajectories

5ig1+-ma::5[llﬂFa]

Ll 180
A AP ARAS VAR 140
P I I 3 S 120
] <> D S 100
RN IAAAN AV &0

RS = i
] ? &
R Openingl 4 0
R . -l 20

K
e Y, _ R
i (3 T R A i A

‘1’ and ‘2’ refer to the principal directions, calculated based on Mohr’s circle.
The first direction is the direction of maximum tension (or minimum compression). The second direction
is the direction of maximum compression ( or minimum tension).

Keep in mind that the most economic reinforcement paths are the ones that follow the trajectories of
the principal directions!
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Plate design

Comparison Mindlin ¢ Kirchhoff

Shear force vx
Combination = ULS; Type forces = Basic magnitudes; Envelope = Maximum; Values = vx

Mindlin
vx-max [kN/m]

649.58
587.50
525.00
46250
400.00
337.50
275.00
21250
150.00
75.00
0.00
-50.00
-100.00
-150.00
-212.50
-275.00
-350.44

Openingl

Section at lower edge

Mesh size = 0,25 m

-370.82 Mesh size = 0,05 m

vx-max [kN/m]

449
400.00
360.00
320.00
280.00
240.00
200.00
180.00
120.00

80.00

40.00

Openingl

Section at lower edge

Mesh size = 0,25 m

205.86

Mesh size = 0,05 m

13



Reinforced concrete (EN 1992) — 2D members

Torsion moment mxy

Combination = ULS; Type forces = Basic magnitudes; Envelope = Maximum; Values = mxy

Mindlin

Openingl

SIGAf

|

L,

mxy-max [kNm/m]

71.80
60.00
50.00

40.00

30.00

20.00
10.00
0.00
-10.00
-20.00

-30.95

Kirchhoff

Opening

=
R

¥ 1A
N

3
B

Section at lower edge

Mesh size = 0,25 m

Mesh size = 0,05 m

mxy-max [kNm/m]

6362
54.00
43.00
42.00
36.00
30.00
24.00
18.00
12.00
8.00
-0.00
-6.00
-12.00
-18.00

-27.65

Section at lower edge

Mesh size = 0,25 m

Mesh size = 0,05 m

Conclusion : Kirchhoff gives the expected shear force values, Mindlin gives the expected torsion

moments.
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Plate design

Concrete setups

1 General setups

Setup 1: National Determined Parameters

Main menu > Project data > National annex [...] > EN 1992-1-1[...]

Concrete setup

B | Type of values
NA building

B Type of funciionality
Hollow core beams
Prestressing

=

&)

= Standard EN
=i Concrete
= General
Concrete
Non-prestressed reinforcement
Prestressed reinforcement
Durability and concrete cover
= ULS
- General
=-5LS
General
- Prestressing
= Allowable stress
Stress limitation during tensioning
SLS stress limitation
= Detailing provisions
- Detailing provisions
Calumng
Beams

= Concrete
B General
Bl Concrete
3 National annex
B[EN_1992 1 1 ]
B gamma_c
Values [-]

B fek_max -
Value [MPa]
alpha_cc - coeff. taking account of long term ef .
Value []
alpha_ct - coeff. taking account of long term eff_|
Value []
k1_red - coeff for calculation of ratio of distrib___
Value [] |
k2_red - coeff. for calculation of ratio of distrib...
Formula |
B k3_red - coeff. for calculation of ratio of distrib...

Value []
B k4_red - coeff. for calculation of ratio of distrib__
Formula
k5_red - coeff. for calculation of ratio of distrib___
Value [] |
k6_red - coeff. for calculation of ratio of distrib...
Value []
alpha_cc.pl-coeff. taking account of long term _
Value []

B alpha_ctpl-coeff taking account of long term e __

Value []

El Non-prestressed reinforcement
O National annex
B EN_1992_1_1
B gamma_s

Values [-]

B eps_ud/eps_uk - ratio of design and characteri...

Value []

8 fyk.up

value of the

a

m

o

a

o

a

m

|150/1.20

13000

1.00

054

|115/1.00

1080

Selectall ] I Unselect all

|

Refresh

l Load default NA parameters l l

Cancel

Setup 2: Basic settings

Concrete menu > Design defaults

Concrete setup

B|Type of values
Design default
Drawing seftings

&)

B

= Design defaults
Concrete cover
2D stuctures
Punching

E Design defaults
B Concrete cover
Use min concrete cover =
Design working life [years] 50
Exposure class XC3
Abrasion class
Type of concrete
Special geometric quality control
Type of concrete surface
Special concrete quality cantrol
B 2D structures
B Upper reinforcement
Diameter [mm]
Angle [deg]
O Lower reinforcement
Diameter [mm]
Angle [deg]
B Punching
B Shear reinforcement

O no

O no

10,0
0.00

100
0.00

Diameter [mm] 100
Geometrical shape

B Support data
Support shape

B Column position

Default distance x*h: x = [ 6,00

None
In-situ concrete

Normal surface

Rectangle

Rectangle

Selectall ] l Unselect all

||

Refresh

15



Reinforced concrete (EN 1992) — 2D members

Setup 3: Advanced settings

Setup menu > Concrete solver

Concrete setup
=] = ECEN Name -~
Code independent values B = Concrete = [Concrete 'l
Code dependent values B = General B General
& Caloulation B Calculation
Generel B/General
2D structures "
SouLe Number of iteration steps 100
% Shear Precision of iteration [%] 1
20 structures Limit value for checks [-] 1,00
Construction joint E Limit bending pressure zone ratio xufd
Punching Automatic calculation (steel yield limif O no
5 for C12/15.6ll C50/60 5.6.3(2) [] 0,45
Creep for concrete classes higherthan C50/80563(2)[] 035
Crack proaf 52D structures
Code Dependent Deflections Reaq. shear reinforcement -> ¢-s height >= 20cm B yes
7-Detalling provisions Design of pressure reinforcement in plates ® yes
20 stuctures and slaks
Punching B 2D user reinforcement
Warnings and etrars Check of concrete cover for subtracting 2D userrei 0 no
E Special design control
Virtual strut reduction factor [%] [] 80.00
B uLs
B8 Shear
3 2D structures
Shear strutinclination control 623 variable strutinclination method j
Shear effect control 6.2.3(7) shear effect considered in SR2 _~|
B Construction joint
Take into account cos_alpha to formula 625 @ yes
& Punching
O Loaded area
Control perimeters for slab of ceiling ata distance x... 2,00
Control perimeters for foundational slab at a distanc... 0.50
Distance between the perimeter of the loaded area .. 6,00
Dimensions of calumn for use the complete perimet... 3,00
O Shear reinforcement
Min thickness of plate (5.4.3.3 (1)) [mm] 2000
B Calculation of shear resistance
Include normal force to punching calculation O no
B Column heads v

[ Selectall H Ungelectall

| |

Refresh

All of the adjustments made in one of the three general setups are valid for the whole project , except

for the members to which ‘Member data’ are added.

2_ Member data

It is possible to overwrite the data from the general setups per 2D member, namely by means of

Member data; see Concrete menu > 2D member > Member data.

On a plate with Member data appears a label, e.g. DSC1 (= Data Slab Concrete). This label can be
selected at any time to view or to adapt the data via the Properties menu. Since Member data are

m-i
additional data, it is possible to copy them to other plates, via ‘Geometry manipulations’ toolbar

via a right mouse click.

16




Plate design

.D Data slab concrete

[t

e

[ ] CIW

cel de

olg 1 |

Type of cover
Different layers per side
User reinforcement
User input thickness
Main reinforcement steel
‘Shear reinforcement steel
2 Longitudinal
First direction angle [deg]
Mumber of reinforcement layers
81
Diameter (du.dl) [mm]
Layer angle
Conerete cover (cu.cl) [mm]
B2
Ciameter (du,dl} [mm)]

Layer angle

Name Dsc
20 member
[Type | Plate
Advanced mode =
E Basic data |
Type of reinforcement geometry | Orthogonal

use minimal cover
O

la

O

B 5004

B 500A

[0.00

100

0.000

Le

iz

Le

17



Reinforced concrete (EN 1992) — 2D members

ULS design

1 Theoretical reinforcement design
Internal forces

Concrete menu > 2D member > Member design > Internal forces ULS

Basic magnitudes

The values shown here are exactly the same as in the Results menu; they are calculated by the FEM
solver.

The example is continued with the results based on the Mindlin theory.

Design magnitudes

The values shown here are different from those in the Results menu.

- The design magnitudes in the Results menu are calculated by the FEM solver according to some
simple formulas specified in EC-ENV.

- The design magnitudes in the Concrete menu are calculated by the NEDIM solver, where a much
finer transformation procedure is implemented, based on the theory of Baumann.
These are the values that will be used for the SCIA Engineer reinforcement design.

For more detailed information, reference is made to the Benchmark examples added at the end of this
manual.

Take a look at the available values: m1+, m1-, m2+, m2- (and mc+, mc-)

“+" and “-“ stand for the design values at respectively the positive and the negative side of the local z-
axis of the 2D member.

“1" and “2” stand for the reinforcement directions, which are by default respectively the local x- and y-
direction of the 2D member.

(mc+ and mc- are the design moments that would have to be taken by the concrete, but they have no
real significance for the reinforcement design.)

Combination = ULS; Type values = Design magnitudes; Value = m1+

m1+ [kNm/m]

22219
200.00
180.00
160.00
140.00
120.00
100.00
80.00
60.00
40.00
20.00
0.00

7l

Compare the result for this value m1+ (Concrete menu) with the result for the equivalent value mxD+
(Result menu) shown on p.10.

Despite the different transformation procedures, the general image of the results will be similar for
orthogonal reinforcement directions (acc. to the local x and y axes). The largest difference is caused by
the ‘shear effect’ / ‘shift of the moment line’ that is only taken into account in the design magnitudes
calculated by the NEDIM solver (values m1 and m2).

18



Plate design

Shear effect / Moment shift

The notion ‘shear effect’ is used for the additional tensile force in the longitudinal reinforcement,
caused by shear.

This additional tensile force is nothing else than the natural force complement to the stirrups force, both
representing, together with the concrete strut force, the resistance of the reinforced concrete continuum
to shear force impact. The thus required additional longitudinal reinforcement is no increment to
bending reinforcement, but an autonomic longitudinal shear reinforcement, complementary to the
(lateral) stirrups. In low-height cross-sections, the longitudinal shear reinforcement is usually
constructively merged with the tension reinforcement (due to m/n).In high cross-sections it has to be
dispersed along the cross-section height.

In EN 1992, 2 approaches are described to take this additional tensile force into account in the
reinforcement design:

1) The ‘shear effect’ approach — EN 86.2.3(7)

This approach is meant for members with shear reinforcement.

The additional tensile force, AF, in the longitudinal reinforcement due to shear Vg4 is calculated from
AFy = 0,5 Vgq (cOtB - cota) (EN formula 6.18)

and (Mgy/z) + AFyy £ Mggmax/Z, Where Mgg max IS the maximum moment along the beam.

2) The classic ‘moment shift’ approach  — EN 8§9.2.1.3(2) and 8§6.2.2(5)

— For members without shear reinforcement, AFy may be estimated by shifting the moment curve (in
the region cracked in flexure) a distance a, = d in the unfavourable direction.

— For members with shear reinforcement, this ‘shift rule’ may also be used as an alternative to the
‘shear effect’ approach, where a, = z (cotd - cota) / 2. (EN formula 9.2)

In SCIA Engineer there are 3 options to control the ‘shear effect’ in the 2D reinforcement design.
The choice can be made in the Setup menu > Concrete solver > ULS — Shear — 2D structures:

Caonstruction joint
Punching
=-S5l
Creep
Crack proof

Concrete setup
Ell = EC-EN MName
Code independent values [z} = Concrete = Concrete
Code dependsnt values B = Genaral General
= Calculation 8 uLs
General o Shear
2D structures
o ULS B 2D structures
- Shear Shear strut inclination control 623 variable strut inclination methad j
2D structures ISheareﬁect:ontrolBZ.Zi(T) no shear effect considered v

Construction joint
Punching
SLs
Detailing provisions
Warmings and errors

no shear effect considered
shear effect considered in SR 2

shear effect considered unconditionally

Code Dependent Deflections
= Detailing provisions
2D structures and slabs
Punching
Warnings and errars

a) Shear effect considered in SR2

The value of AFy is calculated directly (EN 86.2.3(7)), which is in fact the most accurate approach.
‘SR2’ stands for shear region 2, which is defined by the DIN 1045 terminology as the region where
shear reinforcement is required to resist vgg.

This is the default setting in SCIA Engineer, which explains the design moments m1+ along the upper
and lower edges of the plate (see image on previous page). Because of the high (singular) shear
forces along the free edges, also a high value of AFy is obtained, which is accounted for in the design
moments.

b) No shear effect considered
The ‘moment shift’ approach (EN §9.2.1.3(2)) is applied.
If this option is activated, the result for m1+ is as follows.

Combination = ULS; Type values = Design magnitudes; Value = m1+

19



Reinforced concrete (EN 1992) — 2D members

m1+ [kNm/m]

140.78
130.00
120.00
110.00
100.00
90.00
80.00
70.00
60.00
50.00
40.00
30.00
20.00
10.00

0.00

f | \
c¢) Shear effect considered unconditionally
The same as (a), but the value of AF is also calculated in the region SR1.

‘SR1’ stands for the region where no shear reinforcement is required; the cross-section resists vgq by

the bearing capacity of plain concrete. It is, however non-standard, an option, because some norms,
like NEN 6720 §8.1.1, require the ‘shift’ of the moment line also in SR1.
For design acc. to EN 1992, this is practically not an alternative.
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Theoretically required reinforcement
Concrete menu > 2D member > Member design > Member design ULS

Longitudinal reinforcement
Analogously to the design magnitudes, the available values here are: As1+, Asl-, As2+, As2-

Combination = ULS; Type values = Required areas; Reinforcement = Required reinf.; Value = As1+

As1+ [mmA2/m]
2802
2600
2400
2200
2000
1800
1600
1400

I
I
I
/1/ i

lll’ RSV

b lll
AfflilI I —==c

ThIS is the longitudinal reinforcement, calculated based on the design magnitude m1+.
In the tension zones, a minimum reinforcement area is taken into account by default, according to EC-
EN §9.2.1.1(1).

Shear force reinforcement
Combination = ULS; Type values = Required areas; Reinforcement = Required reinf.; Value = Asw

Asw [mm*2/m~2]
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Reinforcement directions & layers

The convention for the reinforcement areas is obviously the same as for the design magnitudes:

“+” and “-“ stand for the reinforcement areas at respectively the positive and the negative side of the
local z-axis of the 2D member.

“1" and “2” stand for the reinforcement directions, which are by default respectively the local x- and y-
direction of the 2D member.

The user is free to change the default direction angles and, moreover, add a 3" reinforcement
direction. This is only possible via Member data:

.|: Data slab concrete

Name |DsC1 [~
du 20 member : [l
l —I» Type ' Plate R
» - .cu - Advanced mode =
E Basic data
7 < | [Type ofreinforcement geometry [ User -
Type of cover use minimal cover =
@ ® Different layers per side L=
T C|I User reinforcement =
User input thickness [} |
dl Upper reinforcement steel B 500A -
Lower reinforcement steel B 5004 -l
cel de Shear reinforcement steel (B 500A -|..|
e ——un B Upper
U P ldp L, Number of directions 3 R
First direction angle [deg] 45,00
Second direction angle [deg] 135.00
Third direction angle [deg] 90.00
Mumber of reinforcement layers 10 i
21
Diameter (du) [mm] 0.0 =
Layer angle 45.000 52
Concrete cover (cu) [mm] |
Basic distance [mm] 200 |
=2 '
Diameter (du) [mm] 10,0 55
Layer angle 135.000 =
Type of cover |layer on previous layer iz

Concrete cover [mm)]

Basic distance [mm] |200 |
=3 '

Diameter (du) [mm] 1100 -

Layer angle 90.000 |

Type of cover |layer on previous layer j

Concrete cowver [mm)] |

Basic distance [mm] 1200 |
=4 [
Load default values >
Concrete Setup e

OF, | Cancel

Up to 10 reinforcement layers per side (top / bottom) can be created; to each layer one of the 3
directions is assigned.

Attention : Layers are always numbered from the outside to the centre of the 2D member!
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Errors & warnings
Concrete menu > 2D member > Member design > Member design ULS

At the bottom of the Properties menu, go to Actions > Calculation Info:

[ calculation Info

B&|| 150 m wox - W T defaut - B = defaut -

warnings and errors for slabs ~
Slab No. Type Description

Slab1 1|Waming |Calculation successful. There are no wamings or no emors.

Slab1 6 | Error Allowable concrete strut pressure exceeded.

The eror message concerns the virtual concrete strut, which symbolises the stiffening function of the
concrete continuum, failing due to the actual load impact. ?? Try a higher cross-section or a higher
concrete class. Choosing another reinforcement geometry may be the optimum solution (‘trajectory
reinforcement”). Purely increasing the reinforcement amount is, however, inefficient.

Slab1 7 |Error Cross-section generally not designable.

The cross-section is exhausted in sense of reinforcement concrete design. Try a higher cross-section
or a higher concrete class for given load impact. More efficient reinforcement geometry may help, too.
Slab1 8 | Error Shear: concrete bearing capacity exceeded.

The shear proof cannot succesfully be accomplished Try a higher cross-section height or a higher
concrete class. In special situations also higher amount of longitudinal reinforcement may help, eg.
reinforcement provided by user, provided (practical) reinforcement.

Slab1 9| Error Cross-secfion non-designable for several reasons.
More than one of possible non-designability conditions were encountered.
Slab1 101 |Waming |Tension reinforcement.
Slab1 103 |Warning | Minimum constructive reinforcement superposing statically required tension reinforcement
Slab1 151 |Warming | Pressure reinforcement (generally).
Slab1 200 |Waming |Shear reinforcement is not required.
Slab1 201 |Waming | Shear reinforcement required.
[ Ready )] £ | 2 e
| | warnings and errors |
[ Listfor for slabs |

This gives an overview of all the warnings and errors present in the project.

Warning = Information about the applied reinforcement.
Error = Real (theoretical) design problem: the result value cannot be calculated.

Most common errors

- Error E8: Shear: concrete bearing capacity exceeded

This error message is found at locations with high peak values for the shear stress. Most of the time
these peak values are singularities, and do not occur in reality. You have roughly 2 options: you can
just ignore the peaks or average them, for example by means of Averaging strips.

- Error E6: Allowable concrete strut pressure exceeded

This means in fact that the resistance of the virtual concrete strut is exhausted, so the concrete strut
gets ‘crushed’. This is a way of failure that isn't considered in any other calculation software (according
to the developer of our solver), but is a real issue. The virtual concrete strut symbolises the stiffening
function of the concrete continuum. The pressure in the strut may not exceed 80% of the concrete
strength fcd (this reduction coefficient can be adapted in the Concrete Setup), in order to provide for
the effective diminuishing of the ‘plain’ concrete strength due to parallel cracks. Failure of the strut is
generally caused by inefficient reinforcement geometry.

The solution is to try a thicker cross-section or a higher concrete class, this is generally the easiest way
to improve the bearing capacity of the concrete strut. Choosing another reinforcement geometry may
be the optimum solution (“trajectory reinforcement”, following the principal directions), but is less
practical. Purely augmenting the reinforcement amount is, however, inefficient. Also the use of
Averaging strips won't help in most of the cases of E6 errors, because we are not dealing with a
singularity here.

Measure 1: Averaging strips

Concrete menu > 2D member > Averaging strip
Add averaging strips to the short sides of the opening, where the line supports are located. Also above
the line supports over the total width of the slab, an averaging strip can be added.
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LIRS
MName RS1
Type Strip j
Width [m] 0,700
Direction | both j

As a basic rule, take the width of the averaging strips equal to the width of the support + 1 to 2 times
the thickness of the slab.

When asking results now, select the option ‘Averaging of peak’ in the Properties menu!
System

Show errors andwarmnings &
Print explanation of errors .. O
Use user scale isolines O

Averaging of peak ]

Location In nodes, avg. |~

Type values Required areas - |—
| IS T »

When asking the values for the theoretical reinforcement again, the errors E8 don’t appear anymore:

Longitudinal reinforcement
Value = Asl+

As1+ [mmA2/m]

2264
2000
1800
1600
1400
1200
1000
800
i 7lE. 800
7E 400

200
N ;

e

L

\

A

Shear force reinforcement
Value = Asw

Asw [mmA2fmA2]

2116
1800
1600
1400
1200
1000
800
600
400
200
0

TN,
=27
P
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Measure 2: Increasing the concrete grade

In the Properties menu of the slab, choose for a higher concrete grade: C25/30 instead of C20/25.

After a new linear calculation, and when asking the values for the theoretical reinforcement again, the
error E6 has also disappeared:

Longitudinal reinforcement
Value = Asl+

Asl+ [mmA2/m]
2165
1800
1600
1400
1200
1000
800
600
400
200
0
I
!
|
I
Shear force reinforcement
Value = Asw
Asw [mm*2/m~2]

2078
1800
1600
1400
1200
1000
800
800
400
200
0

/|
1l
I
|':

1
I

kil Iha

{f
I

SR N
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Extra feature: User scale isolines

Keep in mind that this feature is no basic reinforcement, it's only an adaptation of the graphical display

for the results:

R - [
System Loca
Show errors and warnings B
Print explanation of errors ... |0
Use user scale isolines =
User scale isolines Isolines 1 v|
Averaging of peak =
Location es, avg
j SRS RS- m - — Iv
Scale of isolines m
MName IISDIines1
— Mew level Mean
Diameter ID,D ID 0 ID 0 ID,D mrr
Distance ID ID ID ID mrr
Amount ID ID ID ID mm”2
Copy to legend | Clear lewel
—Legend
User default reinforcement | Mean | As [mm™2] |
10.0-200.0 + 12.0-100.0 11.3-66.2 162367
10.0-200.0 +12.0-200.0 11.0-99.2 95819
10.0-200.0 10.0-200.0 39270
Delete actlewvel | Delete all
oK I Cancel |

Longitudinal reinforcement

Value = Asl+
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Basic reinforcement

This is a reinforcement amount added to the whole plate. In SCIA Engineer, the basic reinforcement is
referred to as user reinforcement

Defining (theoretical) basic reinforcement is only possible via Member data.

Select the plate, choose the option ‘User reinforcement’, and input a Diameter and Basic distance for
directions 1 and 2.

If you select also the option ‘Different layers per side’, it is possible to define the upper and lower
reinforcement independently from each other.

'Name DSC1 |~
du iZD member Slab1 _:_
cuf e ———— E
e . a—va/ |l |Advancedmade B !
5 Basic data 1l
7 i | Typeofreinforcementgeometry  Orthoganal =
. Type of cover use minimal cover x
=
LS ® T C|I User reinforcement 1= .
|| Userinputtickness o 13
dl Upper reinforcement steel (B 500A A
Lower reinforcement steel bl i P28
ce de Shear reinforcement steel | B 500A s
= B Upper |
——CQI ® dp b First direction angle [deg] 000 |
Mumber of reinforcement layers 2 ;]
e ;
|Diameter (du) [mm] (10,0 =
\Layer angle il 0.000 Jid
Concrete cover (cu) [mm] |30 |
|Basic distance [mm] 200 j
22 . |
Diameter (du) [mm] 1100 -
Layerangle | 30000 ]

To view the modifications, go to 2D member > Member design — Design ULS. For Combination = ULS
ask Reinforcement = User / Additional / Total reinforcement, with Value = As1+

As1+ [mmA2/m]
Constant value 383

User reinforcement Asl1+
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Additional reinforcement As1+

As1+ [mmA2/m]
1772

Total reinforcement As1+

As1+ [mmA2/m]
2185
1800
1600
1400
1200
1000

Take a look at the legend to see the difference in result values between additional and total
reinforcement.
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2_Practical reinforcement design

Basic reinforcement

It is logical to start with the definition of a practical reinforcement amount added to the whole plate. This
can be done via the Concrete menu > 2D member > Reinforcement 2D.

A question appears, if the theoretical basic reinforcement (defined via Member data) should be
transferred to practical reinforcement. Choose ‘Yes'.

"
5

Scia Engineer

<2 Member Data on 2D Member specifying orthogonal type of reinforcement with non-zero basic-distance were found.
\'/ Do you want to generate 2D reinforcement on the whole member automaticaly?

Attention : From the moment practical reinforcement has been added to a member, the total amount of
practical reinforcement is accounted for as the user reinforcement. This means that the theoretical
basic reinforcement (defined via Member data) is overwritten!

Additional reinforcement

In a second step, additional reinforcement might be defined on specific location(s) on the plate. This
can be done via the same option - Concrete menu > 2D member > Reinforcement 2D.

The locations where additional reinforcement is required, can be asked for via the Concrete menu > 2D
member > Member design — Design ULS. Since the present practical reinforcement is the User
reinforcement, ask for Combination = ULS, Reinforcement = Additional reinforcement.

This extra reinforcement is to be added separately at the upper and lower side, and in the different
reinforcement directions.
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ULS + SLS design

In this design process, next to the ULS requirements, also the requirements for cracking (SLS) are met.

1 Input data for crack control
Maximum crack width

The values of the maximum crack width (w,.) are national determined parameters, dependent on the
chosen exposure class. Therefore, this value can be found in the setup for National Determined
Parameters, via the Main menu > Project data > National annex [...] > EN 1992-1-1[...].

Concrete setup
=] = EGEN Name
NA building = Concrete =/Concrete
B Type of functionality =- General General
Hollow core beams Concrete ) uLs
Prestressing B Non-prestressed reinforcement B sls
Prestrassed reinfarcement
B General
Durability and concrete cover °
o ULs () National annex
General B k3_crack - coefficient for calculation maxi__
Punching Value [-] 340
=-S5l B k4_crack - coefficient for calculation maxi__
Genaral Value [] 043
= Detailing provisions B w_max
2D structures and slabs IVa\ues [mm] [04/03/03

Funching Detailing provisions

Reference: EN 1992-1-1, Clause 7.3.1(5)

D p Maximum calculated crack width for rei d members and p d members
with unbonded tendons and for

A) exposure classes X0 and XC1

B) exposure classes XC2.XC3 and XC4

C) for other exposure classes
Application: For 1D members: Check cracks
For 2D members: Design reinforcement for ULS and SLS

[ Selectall ] I Ungelact all l [ Riefresh l I Load default NA pararmeters l [ oK I I Cancel

The NEDIM solver will perform the crack control for 2D members.

The approach differs from the crack control for 1D members, where a value of the crack width is
calculated and then checked against the value of wp,. For 2D members, the crack width is
automatically limited during an iteration process (to 0,3 or 0,4 mm - based on the chosen exposure
class).

Class ‘All ULS+SLS’

According to the Eurocode, the requirements for cracking have to be met under the quasi-permanent
load combinations.

The intention of the ULS + SLS design is to give the user a required reinforcement amount that meets
the ULS and cracking requirements. Therefore a class ‘All ULS+SLS’ has to be created, where at least
one ULS combination and at least one quasi-permanent SLS combination are included. The NEDIM
solver will first calculate the theoretical required reinforcement based on the ULS combination(s), and
store the results in its memory. For this reinforcement amount (As,ULS) is then a crack control
performed, based on the SLS combination(s). In the finite elements where W, < Wnax, the value of
As,ULS is sufficient (As,ULS > As,SLS). In the finite elements where W¢y . > Whay, €Xtra reinforcement is
added during an iteration process, until Weaic < Wiax-

The required reinforcement that results from the ULS + SLS design is thus the maximum of (As,ULS;
As,SLS), and will be used in most cases as minimum value for the practical design.
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2_Theoretical reinforcement design

Concrete menu > 2D member > Member design > Member design ULS+SLS

Longitudinal reinforcement
Analogously to the Member design ULS, the available values here are: Arl+, Arl-, Ar2+, Ar2-

The subscription ‘s’ is replaced here by ‘r' to make clear that the requirements for cracking are
accounted for in these values.

Class = All ULS+SLS; Type values = Required areas; Reinforcement = Required reinf.; Value = Ar1+
Select the option ‘Averaging of peak’!
Arl+ [mmA2/m]

1800
1600

L

Maximal bar diameters
Class = All ULS+SLS; Type values = Maximal diameters; Value = fr1+
Select the option ‘Averaging of peak’!

fri+ [mm]

50.0
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Maximal bar distances
Class = All ULS+SLS; Type values = Maximal distances; Value = sr1+
Select the option ‘Averaging of peak’!

sr1+ [mm]
1000

3_Practical reinforcement design

The procedure is exactly the same as for only ULS design, therefore reference is made to the previous
chapter ‘ULS design'.
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Crack control
1 _Input data for crack control

Maximum crack width

For information about the values of the maximum crack width (W) taken into account by SCIA
Engineer, reference is made to the previous chapter ‘ULS + SLS design’.

Combination SLS

According to the Eurocode, the requirements for cracking have to be met under the quasi-permanent
load combinations.

The intention of the Crack control is to check if these requirements are met for 2D members with a
certain reinforcement amount. The theoretical or practical reinforcement design has already been done
in advance, therefore no class ‘All ULS+SLS’ is needed. The check will be executed only for the SLS
combination(s).

Type of used reinforcement

The reinforcement amount in a 2D member for which the Crack control will be executed, is referred to
as As,tot or As,user.

User reinforcement As,user
= Basic reinforcement (as defined via Member data)
= Practical reinforcement (as defined via Reinforcement 2D — if practical reinf. is
designed, then its amount overwrites any basic reinf.)
Total reinforcement As,tot
= Required theoretical reinforcement  (if As,user = 0)
= As,user + As,additional (if As,user # 0)

2_Results for required theoretical reinforcement

Concrete menu > 2D member > Member check - Crack control

If you are interested in the results of the Crack control for the required theoretical reinforcement
amount, then no basic nor practical reinforcement may be present! In the Properties menu, the ‘Type of
used reinforcement’ = ‘As,tot’.

To be able to get any results for the Crack control, the required theoretical reinforcement has to be
stored at first. So go to Member design ULS or Member design ULS+SLS, and refresh the results.

For this example, the results for Member design ULS+SLS are stored, where the calculated required
reinforcement meets the requirements for cracking. Therefore we expect to find crack widths with a
maximum value of 0,3 mm (according to the chosen exposure class XC3).

Attention : This is nevertheless only the case if the results for Member design ULS+SLS are stored
without averaging of peaks!
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Crack width w+
Combination = SLS; Type of used reinforcement = As,tot; Value = w+

[rgem
0.240
({a NN
‘L 0.090
[ 0.030
{ \ e 0.000
\ \ 0.000
e
4
[ B
T \
| . S
=
Crack width w-
Combination = SLS; Type of used reinforcement = As,tot; Value = w-
v
0.100
0.080
o0
T Ta
e T T T
i e e T B T T T,
b i Sy
e e
T ———c e S
—
Unity check
Combination = SLS; Type of used reinforcement = As,tot; Value = Check value
Check value []
0.89
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A green value stands for a Unity check < 1 (W¢yc £ Wmax), While a red value means that wy,,y is

exceeded.

3_Results for basic reinforcement

Concrete menu > 2D member > Member check - Crack control

If you are interested in the results of the Crack control for the basic reinforcement amount defined via
Member data, then no practical reinforcement may be present! In the Properties menu, the ‘Type of

used reinforcement’ = ‘As,user’.

The necessary additional reinforcement is not taken into account here, so it is probable that we will find

crack widths larger than 0,3 mm.

Crack width w+
Combination = SLS; Type of used reinforcement = As,user; Value = w+

Concrete 2D doto

—
T
— ™
i T
M e
=
Crack width w-

Combination = SLS; Type of used reinforcement = As,user; Value = w-

e T S
o o e e e e T T T
| T e T Tl T

w+ [mm]
0870
0310
0720
0830
0.540
0.450
0.360
0.z70
0.180
0.090

0.000
0.000

w- [mm]
0.478
0.450
0.400
0.350
0.300
0.250
0.200
0.150
0.100
0.050
0.000
0.000
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Unity check
Combination = SLS; Type of used reinforcement = As,user; Value = Check value

Check value []
290

1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00

0.00

A green value stands for a Unity check < 1 (Wcqc < Wmax), While a red value means that Wi,y is
exceeded.
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Annexes

Annex 1: Conventions for the results on 2D members
1 Basic magnitudes = Characteristic values

Bending (plates, shells)

*Bending moments mx, my

P

% HI,Z—LUY-Z dz

*Torsion moment mxy

*Shear forces gx, qy (=vx, vy)

ZP
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Membrane effects (walls, shells)

*Membrane forces nx, ny

ZP
S
,_."
_/'/
_/j
/{'
g / //
nx
*Shear forces gxy (=nxy)
ZP

/ q:qr qx’? - LTX}F dZ

2_Principal magnitudes

The principal magnitudes give the results according to the axes of the directions of the largest stresses
(principal directions). These directions are defined with the help of the circle of Mohr.

3_Design magnitudes

To derive the design magnitudes from the basic magnitudes, formulas from the Eurocode EC-ENV are
used.
See also the Help menu > Contents > Reference guide, for these formulas.
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Annex 2 : Results in Mesh elements and Mesh nodes = 4 Locations

During a calculation in SCIA Engineer, the node deformations and the reactions are calculated exactly
(by means of the displacement method). The stresses and internal forces are derived from these
magnitudes by means of the assumed basic functions, and are therefore in the Finite Elements Method
always less accurate.

The Finite Elements Mesh in SCIA Engineer exists of linear 3- and/or 4-angular elements. Per mesh
element 3 or 4 results are calculated, one in each node. When asking the results on 2D members, the
option ‘Location’ in the Properties window gives the possibility to display these results in 4 ways.

1 In nodes, no average

All of the values of the results are taken into account, there is no averaging. In each node are therefore
the 4 values of the adjacent mesh elements shown. If these 4 results differ a lot from each other, it is
an indication that the chosen mesh size is too large.

This display of results therefore gives a good idea of the discretisation error in the calculation model.

12 ] 18 24 | 30
9118 290 31
M| 18 24 | 29
9117 24 30

2_In centres

Per finite element, the mean value of the results in the nodes of that element is calculated. Since there
is only 1 result per element, the display of isobands becomes a mosaic. The course over a section is a
curve with a constant step per mesh element.

|

3_In nodes, average

The values of the results of adjacent finite elements are averaged in the common node. Because of
this, the graphical display is a smooth course of isobands.

In certain cases, it is not permissible to average the values of the results in the common node:
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- At the transition between 2D members (plates, walls, shells) with different local axes.
- If aresult is really discontinuous, like the shear force at the place of a line support in a plate. The
peaks will disappear completely by the averaging of positive and negative shear forces.

4 In nodes, average on macro

The values of the results are averaged per node only over mesh elements which belong to the same
2D member and which have the same directions of their local axes. This resolves the problems
mentioned at the option ‘In nodes, average’.

14| 14 25 | 28
14 1 14 78 | 28
153113 i
1313 2T E7

Accuracy of the results

If the results according to the 4 locations differ a lot, then the results are inaccurate and this means the
finite element mesh has to be refined. A basic rule for a good size of the 2D mesh elements, is to take
1 to 2 times the thickness of the plates in the project.
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Annex 3: Local Coordinate system for 2D mem

bers

The results for a Finite Element analysis are computed according to the Local Coordinate System
(LCS) of each mesh element. As a consequence, these results depend on the way the local axes for

mesh elements are defined. A wrong definition of local axes

can lead to very misleading results.

Let's consider the example below. A continuous plate is modeled as two elements D1 and D2:

In order to display the mesh local axes, you need first to generate the mesh. You can use the button

‘Mesh generation’ i or Main menu > Calculation, Mesh > Mesh generation

Afterwards, the mesh and local axes can be displayed from
the mouse on the screen

View parameters setting

‘Set View parameters for all : right click of

|| Check / Uncheck group Lack position 7
| B stributes ! Mise. | [&] Miew |
I_ Labelz | [E] Model | Loads/masses |

Structure
Panel
E Structure nodes

Display v

b ark style: Ciat ;J
E Mesh

Diraw mesh v I

Tee edoes 4

Dizplay mode wired __:_l
E Local axes

Modes r_'

Members 20 =

Mesh elements v 1
-| Seclions

Members 10 v

Members 20 v

QK ] | Cancel

Itis clear from the orientation of the axes that the continuity of the moments mx and my cannot be
satisfied. The moment mx on D1 corresponds in this case to the moment my in D2.
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The moment mx on a section of the plate gives the Moment diagram1. After correction of the local axes

orientation, Moment diagram?2 is obtained.

Moment diagram 1

Moment diagram 2

By default, the program computes the local axes automatically. The user can adapt the direction of the

axes in several ways using the Properties menu:

Properties o =
2D member (1) |\l V7
& %
Name Dz
Type plate (30) |
Analysis model Standard |
Shape Flat
Material C30/37 ]
FEM model Isotropic |
FEM nonlinear model | none hd
Thickness type constant |
Thickness [mm] 200
Member system-plan... | centre j
Eccentricity z [mm] ]
LCS Type Standard -
Swap orientation Standard
LCS Angle [deg] Perpendicular to vector
Layer Congruent with Iilje
Smallest angle with vector
Bl Nodes Tilt of wector defined by point
N1 Titt of vector nomal to line
N4 abso

42



Annexes

1 Perpendicular to vector

The local axis x(y) is perpendicular to a vector that is defined with its coordinates V(x1 y1 z1).

+  Properties o x
(20 member (1) DAY
& 5
Name 51 -
Type plate (50) j
Analysis model Standard j
Shape Flat
Material C12/15 ..
FEM model lsotropic j
FEM nonlinear model | none j
| Thickness type constant j
~ | | Thickness [mm] 200
Member system-plan... | centre j
L Sod L 1 0
LCS Type Perpendicular to vector ﬂ
Local axis « by vector j
«1 [m] 4,000 o =
v1 [m] 0.000
z1]m D.%D
Swap orientation O no
LCS Angle [deg] 0,00 . J.

The coordinates of the vector can be introduced in the properties window. You can also use the o]
button next to x1 and define the vector graphically with a start point and end point.

2_ Tilt of vector normal to line

This method is similar to the one above. Instead of introducing a vector, a line is defined between two points.
(x1 y1 z1) are the coordinates of the first point and (x2 y2 z2) are the coordinates of the second point. The
x(y) axis is perpendicular to the introduce line and points towards it.

= Properties o x
(2D member (1) DAY Y

Name 51 -
Type plate (30) j
Analysis model Standard ﬂ
Shape Flat
Material C1215 Ll_
FEM model lsotropic |
FEM nonlingar model | none |

I Thickness type constant hd
Thickness [mm] 200
Member system-plan... | centre -
Eccentricity z [mm] 0
LCS Type Tiit of vector nomal ta fine v |
Local axis « by point hd E
«1[m] 0.000 ]
y1[m] 0.000
z1 [m] 0.000
8,000 =]
y2 [m] 0.000
72 [m w

T | |Swap orientation O no

(oAl I nnn

The coordinates of the points that define the line can be introduced in the properties window. You can also
click on the ! button next to x1 and x2 and define these points graphically.

3_ Congruent with line

X(y) is oriented from the center of the element towards the intersection between the mesh element and
the defined line :
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«  Properties 3 x
2D member (1) VB 7
& n
Name 52 L
Type _shell (98) ] I_
Line by two points, Analysis model | ?tandard |
P - Shape | Curved
Material C12415 _v_j_
— FEM model | lsotropic LI
—' | |FEM rionlinear model | none d |
Thickness type | constant |
Thickness [mm] 1200
Member system-plan... centre ;J
Eccentricity z Jmm] ]
LCS ﬁpe _Congn.lerrt with line 52
Local s ¥ by paint id E
x1 [m] li}.[H}D ]
y1m] 1}1}{}1}
z1 [m] lﬂ'.l}ﬂ"D
%2 [m] |0.000 =
y2 [m] |0.000
z2 [m] 3.000
~ | |Swap orientation O no
LCS Angle [deg] | 0,00 |
Layer Loy |
= Nodes |

4 Smallest angle with vector

X(y) is oriented such that it makes the smallest angle with the defined vector V(x1 y1 z1).

2 . =  Properties o x
P il IO O (2D member () S
# k’ . 2__ ; . & x
s Name |52 -
/——\ Type Ishel 98) =1
i ;-- ) pes . Analysis model Standard _:j
& LV & ; Shape | Curved
: Material 12115 R
\ FEM model | Isotropic fad
“f j_- } FEM nonlinear model | none |
: ey m— | Fig o |_i Thickriess type | constant Rd
>=</ >ﬁ< | Thicknesspm] 200
by ™ & Member system-plan... | centre Rl
L v i ~ - —Somsctictoa i
>5)<r ! LCS Type Smallest angle with vecto |
|# ———K\ Local ads y by vector Jod
% - ¥ 0000 o
. 'N y1 [m] |0.000
\ L] 21 m] |2.000
) i . Swap onentation LI na
-4 }' LCS Angle [degl |0.00 =0
: e ~ |E Nodes
= : - i fL : M4 |abso
ool . - NB abso
K \N\ﬁ: _,// 3 NG [abeo
x . . N7 :absc

5_ Tilt of vector defined by point

X(y) is oriented towards a defined point (x1 y1 z1). This is suitable in case of a circular plates for
example and allows the user to calculate radial reinforcement.
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Annexes

+  Properties o x
2D member (1) | %k
& =
Name 51
Type plate (30) |
Analysis model Standard j
Shape Flat
Material c12/15 -|..
FEM model Isotropic |
FEM norlinear model | none hd
3 Thickness type constant |
— | |Thickness [mm] 200
Member system-plan .. | centre |
Eccertricity z [mm 0
LCS Type Tilt of wector defined by point v |
Local axis « by point hd
0.000 -
y1[m] 0.000
z1 [m] 0,000
Swap orientation O no
LCS Angle [deg] 0,00 ]
Layer Layerl | ..

Remark: All the methods above are about how to adapt the x and y axes. The local z axis is defined

automatically by the program but its orientation can be changed by ticking the box ‘Swap orientation’ in the
Properties menu
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2D Reinforcement Concrete Design of Walls acc. to E N 1992-1-1:2004

Benchmark Example on SCIA Engineer NEDIM Performane (v6)

Dipl.- Ing. Eduard Hobst Ph.D., Development Partner (Concr&E€)A

A. Fundamental Considerations

Introductory note

This benchmark example presents and explains thie features of the 2D reinforcement concrete
design module NEDIM of the program system SCIA Begr 2013.1. The related Code/Norm on
reinforced concrete is the EN 1992-1-1:2004. Tredyais model idVall, i.e. plane structure subject to
inner membrane forces only.

WALL design model

Wall is the most simple of 4 design models dealt wghNEDIM (Wall, Plate, ShellOne-Layey.
Since it is restricted to plain shape and subjeanembrane forces, represented by the inner forces
vector {n,, n,, Ny}, only (no bending), the concrete cover has immacthe Crack Proof only. Because
of the transversal symmetry, there is no differelpesveen the reinforcement on either fadg/+Z,.
Thus, in Walls NEDIM calculates the total reinfament (in each reinforcement direction). However,
the very distinguishing feat of NEDIM, the procesgiof general 2/3 direction reinforcement nets is
active also in thaVall design model. Thus, not only the standard orthaboginforcement net but
arbitrary skew-angle and three-directional netsaarelable options.

Special note on compression reinforcement

Since concrete, according to all Norms, does nsistréension stresses (in strength calculations) th
main task of reinforcement is to take on tensioasses appearing in a reinforcement concrete cross-
section. However, if heavy compression forces @onua 2D structure, compression reinforcement
may be required to support plain concrete. Typjcdtir 2D structures, no statically required
compression reinforcement but minimum compressioe @ needed according to most Norm
stipulations. As a fact, none of the known (pulEth2D design theories, including tBaumanis
theory [1], which was used as the theoretical bais¢he NEDIM design algorithm, do give an
instruction how to design the compression reinfarest. Thus, its design is left to the program sser’
subsequent hand calculation. The 2D situation i&eithe 1D design, where there is no problem to
consider both tension and compression normal fdare®inforcement design.

The NEDIM algorithm has been equipped with verycgeprocedure, enabling the calculation of
compression reinforcement in all stress situat@ma generalization of tHgaumanrs algorithm [1].

In elliptic pressure statem( < n, < 0), there is a consistent solution available,ictwhyields
compression design forces to both/ all 3 reinforeeirdirections, leading directly to either statigal
required or minimum compression reinforcement.

The hyperbolic pressure state ¥ 0, n; <0) appears as a real challenge, also to the 20Oymesi
algorithm. NEDIM offers here a special solutiongp talescribed in some detail in [1] (“Design of
Walls”, Fig.4). The elementary idea is based ugmptinciple of redistribution (1) the resistance to
compression develops in the concrete continuunhéndirection of the " principal forcen, <0, no
matter if there is laid reinforcement (exactly)tivis direction or not; this fact “explains” thelfag of

all classical 2D design theories, which have toeceth arbitrary reinforcement geometry; (2) the
NEDIM algorithm focuses to thEltimate Load Stat§ULS) as the stress situation where the cross-
section may fail due to exhaustion of the resistanicplain concrete to compression. In such a case,
another stress distribution takes place in thegdegioint, engaging the existing reinforcement to
participate in resisting the pressure force; (3) tlis, NEDIM carries out a special inner forces
transformation, which may exceed the elementarygerie level described by thgeneralized inva-
riant relation (5) in [1]; however, it represents a virtually pide state of stress. If there is found
acceptable security for this state of stress, thactsire is considered to be designable with the
compression and tension reinforcement corresportditiys state of exploitation.

In this Paper, paragraph C.4 presents numericakpsing of a hyperbolic stress case with a comsiste
solution, i.e. meeting exactly the invariant redat(5) in [1].
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References

The numerical calculations presented in this Papee been based upon the SCIA Engineer projects
Wall_Benchmark_EN(0), Wall_Benchmark_EN(1) and Wa#nchmark_EN(2), which are integral
parts of this benchmark document [0]. The fundasadetiieoretical information on 2D design is
presented by the SClRheoretical Backgrounchanual [1] (with advanced references there in).

B. Wall Example — Model Definition and FEM Results

A 2D cantilever member subject to considerable Zomttial line load —500 [kN/m] and an additional
vertical tip force —100 [kN/m] was chosen to demmats the feats of the 2D design algorithm NEDIM
under SCIA Engineer:

C 12116, Steel 600, h =100 [mm]
Orthogonal reinforcement net : (0°/ 90°)

F1,/—100.00

_ iz L e o 2 -500,00
E G 7 8 9 10
2 % 1.00 [m] 18 Fou o 1 1 5
L=t
1 2 3 4 5
5N 14 L rd s
an — = — 500,60
T 5 x1.00 [m] T

Fig.1 SEN model of Wall - Geometry and FE mesh

A Eird i el iz =
T T T T "

6% 44 174.45 | 40,02 47 5B

6 7 8 9 10
—GB03.38
14 —: & & : :
1 2 3 4 5
—1212.02-175.53 | 1019 68-1026.52
1 V Il i rd L

=" %

Fig.2 Results of FEM analysis: Inner force$ly — Direct values in element nodes (LC1)
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A Eird 1L deian iz =
T T T T T

122.47 —281.56

& 7 5 4 ]

15549 - 34544
1

as)

—104 77

Fig.3 Results of FEM analysis: Inner force$ly — Direct values in element nodes (LC1)

4, L lrd 1o L k] r}
t T T T T g
4210
& 7 8 4 10
7127 —E£5.58  —155.649
14 13 & o 1 1
—70.E8 —124.22
1 2 3 4 =)
40.80
=" L] = i .
=="7% T B

Fig.4 Results of FEM analysis: Inner force$ly, — Direct values in element nodes (LC1)

C. ULS Design — Statically required reinforcement

In this Chapter, pure statically required reinfonemt is dealt with by the project
Wall_Benchmark_EN(0). To disable the determination of the minimum reggireinforcement,
which may superpose the statically required valitespecification has to be suppressed on ingg (s
Chapter D, Fig.10, showing the SCIA Engin€est defaultConcrete Setup dialogue window for non-
zero minimum reinforcement). One consequence ofpragging the calculation of minimum

compression reinforcement is vanishing of compogsseinforcement in all design points where the

bearing capacity of plain concrete is sufficientdsist compression stress.

The NEDIM design results will be scrutinized inaietn three element nodes, as marked in Fig. 5 and

6, using the special numerical protocol of the NEDIest StrategyC.1 Elliptic tension design case;
C.2 Elliptic pressure design cage;3 Hyperbolic stress state design case.

- - = :
Ao i 33 |0 alo ole )
—— 0 ; ) . |
Case 1(C.1)
o oo G| o olo olo 0
‘IJ\ 1. .E.' e a 1
o ala a0 alo ole )
Case2(C.2) Case 3{C.3)
' | ®| | «+ | @
e, B?f—_\ | 187 186 | o (('o_\ i
A S S

Fig.5 Design results: stat. required horizontal rinforcement ag; [mm2/m] — direct values in
nodes
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i I et I 45 I i I 4 I P
97 I ( ) I a3 I 84 I 50 | 430 I 0

@ 7 8 3 10

Case 1 (C.1)

= ; 3 59 | 58
Case 2 (C.2) Case 3 (C.3)

4 ®

3
| I s{fo\ I oo I |27 I 2?‘ 55\ I
F I £E E I =

I N I

o

Fig.6 Design results: stat. required vertical reiforcement e [mm2/m] — direct values in nodes

C.1 Design Case 1: Statically Required Reinforceme— Elliptic Tension

As seen from Fig.2—4, in element 6, inner node 8sfmnode 13), both basic membrane forces are
positive:n,>n,>0, i.e. tension. Thus, an elliptic tension statexigected.

Table 1 Inner forces [kN/m] (Basic/ Principal/ Desighin element 6, node 1&Test Strategy line 1#)

Fig.7 Graphic representation of Table 1(Case 1 of inner forces transformation)

The generalized invariant relation (5) in [1] isisfed:
Nig+ Nog + Neg = 195.0 + 92.4 — 41.6 256.4

This is a standard transformation case. The defgres {niq, N, N May be, in analogy to
mathematic terminology, considered separated result variablesf the 2D design problem, which
thus disintegrates into three individual pseudodEdign cases. The required reinforcement amount is
calculated as in two mutually independent 1D mesiber

Qsireq = nid”:yd
As1req = nld/fyd =0.1950(600/1.15) = 3.74—4 [m2/m] =374 [mm3/m]
A2 req = n2d/fyd = 00924(600/115) =1.71{-4 [mZ/m] =177 [mmZ/m]

~Nn +nNn;= 178.4 + 68.3- 256.4 [kN/m]

Ny ny Nyy n ny a1 Nyg Mg Ny
1754 7;. 20. 118 608. 10, 15(3)5 95. 41,
' 5 ' 9° ' 0

@ Y ORR: ©
n, = +174.5 n, = +178.4 P 410 | =+195.0
" o
1 Flyy et ny=+6810 ,_ 40qc n,y =j+92.4
o \
n,, =-20.5

(1)

(agreement with Fig.5)

(agreement with Fig.6)

The virtual concrete strut, which function may lbenfiulated as “stiffening of the reinforcement net
against distortion in its plane” is to be checksgkin concrete section with reduced concretagthe
[1] (see Fig.11). With the®1default value of the reduction facig,=0.80 (i.e. only 80% of full design
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strength of concrete, weakened by parallel cratlks;, be applied), the resistance check of the Virtua
strut follows the formula:

—eq < Ifac X fch H (2)
with H — full cross-section height (representing thnit” area ofH x 1[m]). From (2) it follows:
41.00-3 =0.041<< 0.80x12/1.5x0.10 =0.640[MN/m]

The check reveals satisfactory bearing capacigrvesof the stiffening concrete.

C.2 Design Case 2: Statically Required Reinforceme— Elliptic Pressure

As seen from Fig.2—4, in element 2, inner node ésfmmode 11), both basic membrane normal forces
are negativen, <0 andn, <0, i.e. compression. An elliptic compression siatexpected. Table 2
shows that it is true also in the transformed state<0; nyy<O0.

Table 2 Inner forces [KN/m] (Basic/ Principal/ Desighin element 2, node 11Test Strategy line 2#)

Ny Ny Nyy n My ol Mg Mg Ncg
i § § i 90. i i .
101 31. -6.2 31. 101 4° 101 25. 12.
9.7 4 3 9.7 3.5 2 4

@ Y (® Lty © 4
n, =-1019.7 ny=-10197 | Pee=f124 g = 10135
/;’ l){, * 1:'” -
n, =-6.2 +X
n, =-31.4 n =-31.3 S Ny =|- 25.2
+
n, =-6.2

Fig.8 Graphic representation of Table ACase 2 of inner forces transformation)

The generalized invariant relation (5) [1] is d&tid ("numerical” precision):
Nig+ Nyg + Neg = —-1013.5 -25.2 -1241051.1 ~n, +n,; =-31.3 - 1019.7 1051.0 [KN/m]

This is a special NEDIM transformation case. Thguneed reinforcement amount is calculated as in
two mutually independent 1D members:

asi,req = (_nid -H fcd) /f|ycd with f‘ycd = min(fycda Esscl) (3)

In (3) fycq is steel strength in compressiort' (hput default:fycq = f,g); Es — Young’s modulusge —
concrete yield point (bilinear stress-strain coteiagram specifieds; =0.175 %).

Hint: the adapted compression steel stremgthrespects the fact that concrete under centric press
should not be allowed for higher than yield strainys, higher class reinforcement steel does ysuall
not attain its yield point, i.e.f)cg< Ese in most cases. From (3) it follows:

f'yea = Min(600.0/'1.15,200000.6¢0.00175) = 350.0 [MP4a]

As1req = (1.0135-0.10x12.0/1.5) 350.0 = 6.1@~4 [m?/m] =610[mm?2/m] (agreement with Fig.5)
Aspreq = (0.0025-0.10x12.0/1.5)350.0 <0 — ageq=0 (agreement with Fig.6)
Obviously, the virtual concrete strut possesseficserit resistance.

C.3 Design Case 3: Statically Required Reinforcemée— Hyperbolic Stress
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As seen from Fig.2—4, in element 5, inner node ésfimode 9), both basic membrane normal forces
are negativen,<n,<O0, i.e. compression. An elliptic compression sistus expected like in Case 2.
However, the “mixed” membrane componegt which generally imposes a tension effect uporh bot
reinforcement directiong, y, reverts the elliptic pressure state of the homegas continuum to a
virtual hyperbolic stress state, as Table 3 shows.

Table 3 Inner forces [KN/m] (Basic/ Principal/ Desighin element 5, node 4Test Strategy line 3#)

Ny ny Nyy n Ny o, Nyg Nzg Ny
542 14. 48, 10. 547 9250' 494 +3;33 96.
7 6 3 2 1 4 : 6

@ 4 ® v © v

n, =-5427 n, =-547.1 B.i®|-39.8 n,, =-494.4
Ly fp— -
v +X
=|- 14, n, =-48.3 n, =-110.2 n,y =|+33.8
n, =i-14.6 o 1 o = +95,2° 2d

n,, =-48.3

Fig.9 Graphic representation of Table 3Case 3 of inner forces transformation)
The generalized invariant relation (5) [1] is d&tid ("numerical” precision):
Nig+ Nog + Neg = —494.4 +33.8 — 96.6=557.2 ~n, +n; =-10.2 — 547.E 557.3 [kN/m]

This is a very special NEDIM transformation caBaumann[1] and all other transformation theories
would yield the ¥ principal forcen, =—547.1 as the design result, assigning it to taagloncrete as
virtual strut force; no reinforcement would be desd. Effectively, plane concrete design would have
taken place.

The required reinforcement amount is calculatededoc compression, once for tension, i.e. according
to the formulae (3) and (1), respectively:

As17eq=(0.4944-0.10x12.0/1.5)350.0<0 — ag,eq=0 (agreement with Fig.5)
Aspreq=0.0338(600/1.15) = 6.48—4 [M?/m]=65 [mm?/m] (agreement with Fig.6)

Thetensionforce nyy = +33.8, has virtual character (trailing symbol “v”). Und8LS, the reinforced
concrete continuum would act as plain concrete autlparticipation of the reinforcement, whereas in
ULS, a redistribution of inner forces could takaqd, evoking the tension in steel as presentedeabov
As a fact, this statement holds, in cases withiredicompression reinforcement. Obviously, in sase
of minor exploitation, like this one, no redistrtlmn would take place. However, this special desig
solution makes it generally possible, to assignimmim compression reinforcement according to the
Code stipulations — see Table 4.

Hint: the virtual reinforcement amount (her@y.,) is designed, consequently, @snsion
reinforcement !!!

D. Required Minimum Reinforcement

Numerical results and screen copies of this Chaptegre obtained by the project
Wall_Benchmark EN(2).

In this Chapter, the effect of activated minimurinfercement specification according to NEDIM 1
default input, as shown in Fig.10, is dealt withs A fact, the user may modify the settings, but

51



Reinforced concrete (EN 1992) — 2D members

accepting them, legal solution according to therN@ obtained. The position of the virtual stryun
in the Setup dialogue is shown in Fig.11.

o=

= |Type of checks EC-EN Name EC-EN

Design ] =8 Concrete e
[ Design defaults 1# Design defaults
- Concrete cover @
- 2D structures ) el
[l- General # uLs
- Concrete Izl Detailing provisions
[El- Calculation = 2D structures and slabs
2D structures B Setting of chech
i Minimum transverse reirforcement lyes
-General =
. Shear Minimum constructive reirforcement lno
2D structures Minimum pressure reinforcement [V yes
Construction joint WMinimum tension reirforcement on face Zp- yes
EJ- Detailing provisions Maximum degree of reinforcement | yes e
: - 2D structures and slabs Minimal bar distance Fino
=+ Reinforcement and reinforcement des —
- Prestressing post-tensioned Mepimal bar distance L _”° DEEFI BEAM SF'EClFlCATlON
L Warnings and errors Structural reinforcement of wall considered as dee.. |” (no
& Reir no (Chapter D) / yes (Chapter E)
Minimum transverse reirforcement - special cortrol  Inactive reinforcement excluded -
Minimum transverse reinforcement [%] 20

Minimum constructive reinforcement [%]

Minimum pressure reinfarcement [%] |:

Minimum tension lower reinforcement Automatic calculation of minimum tension reinforcemerr =
= Maxi di of reinf:
Value [%] 4
Minimal bar distance [m] 0,05
Mazdimal bar distance [m] 0,20
13 Rei and rei design

# Wamings and emors

Reference: EN 1992-1-1, Clause 9.6.2(1,2)

Description: This |5ﬂ'1&rmfm|.m pressure reinforcement for walls, This is expressed as a percentage of area of
Deesigned 1 is i with minimum reinforcement set. Maximum is provided to the member.

i I v | Application: Design of reirf ,.fanD t

Load default non-NA parameters | Load default NA parameters | oK I Cancel |

Fig.10 Concrete Setup > Detailing provisions > 2Btructures —Minimum reinforcement
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-
B Concrete setup

A

= | Type of checks EC-EN
Design B Concrete

B-Design defaults

Concrete cover

.. 2D structures

B-General

Concrete

&-Caleulation
2D structures

- Construction joint

=-Detailing provisions

“- 2D structures and slabs

=-Reinforcement and reinforcement desigr
Prestressing post-tensioned

-Warnings and errars

4« T m | *

Name EC-EN
= Concrete
1# Design defaults
= General
# Concrete
=l Caleulation
= 2D struchures
Req. shear reinforcement -> cs height >= 20cm Mino
El 2D user reinforcement
Check of concrete cover for subtracting 20 userr... no
= Special design control
8000
H uLs
[# Detailing provisions
# Reinforcement and reinforcement design
[* Wamings and errors

X
fcd,red = m fcd

Reference: Code independent, SIA 262 {Swiss Code on concrete) and German litersture on reinforced concrete may

be refemed to.

Description : Reduction factor {expressed as percentage} of design value of concrete compression strength fed) on

account of cracking possibility of concrete continuum.
lication : Desian of 20 members

Load default NA parameters oK Cancel |

Load default non-NA parameters ] I | I

Fig.11 Concrete Setup > Calculation > 2D structur® > Special design control -Virtual strut
reduction

The minimum tension reinforcement is stipulatedgBy?2.1.1, formula (9.1N). In NEDIM terms:
Asymin = Max(0.26f ¢/ fyk, 0.0013xd  [m?/m] 4)

With fim=1.6,f,=600 [MPa] andd = H —g; = 0.100-(0.030+0.10/2F 0.065 [m] &, is the effective
static height:ia; = ¢; + ¢/2) of the outer reinforcement layer, for consistenvith a corresponding
bending case), thé®erm in (4) is decisive, thu,m,=0.00131=0.00013x0.065 0.0000845 [m2/m].
However, in Walls the total reinforcement is preasdnthus, the resulting reinforcement is double as
much:

Asymin = 2% 0.00131=0.000169 [M?/m] 469 [mm?2/m],
as displayed in Fig.13 in all nodes whegg.& asimin.

4 % -— - 4
33k 169 165 | 200 200 | o 200 | 200 200
5 7 g 9 10
200 200 | 200 200G | 200 200 | 230 200 | 200 200
1 3 = E H 2
200 200 | 200 200 | 200 200 | 200 200 | 200 200
1 2 3 4 5
T 3851 823 250 249 | 200 200 | 200 200
b4 B L =l
=7 =

Fig.12 Horizontal reinforcementag; req+min [MM2/m] — Direct values in nodes
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169 177 183 16% | 169 163 | 169 169 | 430 200

200 200 | 169 189 | 163 169 | 183 186 200
El 1 El

& H T
208 214 | 274 169 169 164 | 189 169

200 169 | 200 20 | 200 200 | 16% 164 | 169 200
4 LX)
A

Fig.13 Vertical reinforcement@g req+min [MM?/m] — Direct values in nodes

The minimum compression reinforcement is governe@%6.2. In 2D structures it is simply specified
as 0.2% of gross cross-section. The correspondinguia in NEDIM isascmin= 0,002H [m3/m].
Hence, in Fig.12 and Fig.13 the value of

8sc min=200[mm?2/m],

prevails since there is low intensity normal foicenost element nodes active. Only in element nodes
at the lower edge, the statically required valukesampression reinforcement exceed the minimum
values (compare with Fig.5).

E. Minimum Structural Reinforcement of Deep Beams

Numerical results and screen copies of this Chapterre obtained by the project
Wall_Benchmark EN(2).

EN 1992-1-1:2004, 89.7 deals with (minimum) struatueinforcement of so called Deep Beams.
NEDIM controls this assignment by the pertinentingption in Concrete Setup > Detailing provisions
> 2D structures, as shown in Fig.10; the checkbax tmen to be activated (yes). The Deep Beam
control option is set inactive in the project vat&@(0) and (1). On the other side, the specificatf
minimum reinforcement (tension and compressioninfitbe variant (1) is maintained in variant (2).
Thus, the reinforcement results obtained here tatestthe absolute "constructive reinforcement
envelope”. The following result displays af s,pandas,s,p in Fig.14 and Fig.15 the original values of
a5 eqWhich have not been exceeded by both minifeonstructive reinforcement controls are marked
by encircling.

The minimum constructive reinforcement DEep Beamsccording to §9.7(1) takes on in NEDIM
terms the following shape:

aspemin = Max(0.001H,0.00015  [m?/m] (5)
Since in Walls the total reinforcement is showée, tesulting constructive reinforcement is doulde a
much.

Numerically:

aspemin = 2% Max(0.001x 0.10,0.00015) 0.0003 [m?/m} 300 [mm?3/m],
This is the value displayed in Fig.14 and Fig.1mst nodes where &y:min<&spamin

Following Table 4 compares the reinforcement desigat the three discussed design staGesen
shadowing marks the stagequiredwhen it is superior tMinimumandDB reinforcementBlue and
Redmark the stagelinimumandDB exceeding the preceding stage(s). Pressure reamfmmt values
are marked with trailing “*".
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33z Fra) 300 0G| 300 300 | 300 Q0| 300 00

6 7 ] 9 10
300 300 | 300 300 | 300 300 | 300 300 | 200 300
14 T £ 5 - =
300 300 | 300 300 | 300 300 | 300 300 | 300 300

1 2 3 4 5
O < 300 300 | 300 F00 | 300 a0
Ty & 4 -

Fig.14 Result envelope: horizontal reinforcemenfls; syp [MmM?2/m] — Direct values in nodes

ER

4 1 1 1
B0 300 | 300 00| 300 300 | 300 300 330
=] 7 = 9 10
300 300 | D0 300 | 300 300 | 300 300 @ 300
14 145 g ) 1
300 Z00 | 300 300 | 300 300 | 300 300 | 300 300
1 2 3 4 5
elie} 300 | 300 00 | 300 300 | 300 a0 | 300 300
= 11 = Fal b

Fig.15 Result envelope: vertical reinforcemenie sup [MM2/m] — Direct values in nodes

Table 4 Comparison of the reinforcement stages investigated design points 6/13, 2/11 and 5/9

Horizontal reinforcement (1) Vertical reinforcement (2)
Elem/Node [mmz/m] [mmz/m]
81 req 8s1 reg+min 8s1.5up As2req 8s2req+min As2sup
6/13 374 374 374 177 177 300
2/11 610* 610* 610* 0 200* 300
5/9 0 200* 300 65 169 300
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2D Reinforcement Concrete Design of Plates acc. to EN 1992-1-1:2004

Benchmark Example on SCIA Engineer NEDIM Performane (v6)

Dipl.- Ing. Eduard Hobst Ph.D., Development Partner (Concr&E€)A

A. Fundamental Considerations

Introductory note

This benchmark example presents and explains thie Beatures of the 2D reinforcement concrete desig
module NEDIM of the program system SCIA EngineeEN$ The related Code/Norm on reinforced
concrete is the Novella of EC2 — EN 1992-1-1:200¢he structural/design model is PLATE, i.e. plane
structure subject to pure bending.

PLATE design model

Plateis one of 4 design models supported by SEN/NEDI&I(, Plate, ShellDne-Laye}. It is restricted to
pure bending, represented by the generalised f@cw®@r {m, m, my, v, w} (membrane forces being absent
by definition). The very distinguishing feat of BB/ — the processing of general 2/3 direction reinf
cement nets — is active also in Plate model. Thus, not only the standard orthogonaifoecement net but
arbitrary skew-angle and three-directional netspassible options of thPlate design model of NEDIM.
The position of each of 2/3 specifiable reinforcatmurses at either fac&#—Z, of the cross-section is of
fundamental meaning for the design, i.e. the caaaever has not only impact on the Crack Proof.

Special note on compression reinforcement

Since structural concrete, according to all knovamrs, does not resist tension stresses (in strexadthla-
tions) the main task of reinforcement is to ret@sion stresses appearing in the tension zoneeahfarce-
ment concrete cross-section under bending. Howefs@ronounced bending moments act upon a plate,
compression reinforcement may be statically reguicestrengthen the concrete compression zoneth©n
other part, no minimum compression reinforcementeiguired with pure bending by any of the known
Norms! NEDIM imposes a restriction to the designcompression reinforcement: the reinforcement
directions (and their number, i.e. 2 or 3) at theek #,/-Z, must be pair-wise congruent; however, not
necessarily in the same specification order. Togtin of each reinforcement course within thessro
section is checked in order to establish its sthrain: courses lying deeply in the cross-sectivght not
have reached the yield strain; the required comnspeseinforcement is then augmented appropriately.

The hyperbolic bendingr{ > 0, m; <0) in plates does not constitute such a challeaglee 2D design algo-
rithm as in other models, which involve the membrérrces. This is, simply speaking, due to the tlaat
no minimumcompression reinforcement is required in plat€hus, it is in every way a standard solution,
when in plates under the elliptic stress state>fn, >0) one face is designed without defined reinforaaime
However, there are also in plates distinguishirmgpthtical and algorithmic features of the hypeibstate of
stress, which have been dealt with great thorousghfig.

References

The numerical calculations presented in this Pd@are been based upon the SCIA Engineer projects
Plate_ Benchmark_EN(0), Plate_Benchmark EN(1) aattPBenchmark_EN(2), which are integral parts of
this benchmark document [0]. The fundamental themeinformation on 2D design is presented by the
SCIA Theoretical Backgroundchanual [1]; in [1] advanced references may be dioamd examined.

B. Plate Example — Model Definition and FEM Results

A quadratic plate supported along all 4 edges,exltp a single Load Case consisting of plane {pad-3.5
andp = —10.0 kN/m?2 and reinforced by congruent orthodjoreds 0°/90° at both faces (in this basic variant)
has been defined to demonstrate the feats andndesiglts of the 2D design algorithm NEDIM unden&C
Engineer. Since the system is double-symmetrity tre “upper/left” quarter of plate’s model willeb
processed here by introducing the appropriate symrbeundary conditions on the central symmetrysaxe

(Fig.1).
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C 20125, Steel 500, h = 250 [mm] N
Orthogonal reinforcement nets: (0°/90°)

~0.3 28| -01 23 |-00 21|06 20 | B2 1.7
il 2 23 24 25
1.2 6.7 | 8.0 701 147 | 150 164 | 165 16.3
2 - = = - -
~0:3 04 |42 137 | 8.7 163 | 138 177 | 1684 177
16 17 18 19 20
~60 1T | 103 198 | 185
2 b 2 i :
~0.3 127|723 201 | 15,7
11 12 13 14 15
~01 14 345 | 336 355
14 = i b + e
~0:2 144 |93 337 | 821 343
8 7 8 g 10
% sE | 118 535 |36 @7 | Be4 3B
33 == < = 1 :
~g2 153 | 106 s 330 (208 374 [3sa  37e
1 2 5 4 5
'1"—0.2 155 | V.3 341 | 312 384 | 369
N 14 c =2 P
FaY T

Fig.2 Results of FEM analysis: Inner moment$ly max — Direct values in element nodes (ULS)
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Fig.3 Results of FEM analysis: Inner moment$yy max — Direct values in element nodes (ULS)

|@ 300 | 303 15.3 7.0 ~0.1
21 22 73 24 25
300 268 | 283 14,0 6.3 ~0.2
i s 7 22 = 3
30.3 283 | 207 5.2 | 167 75 -0.0
18 17 18 19 20
L3 | ¥ 54|76 -0
2 15 3 3 :
13.1 | 127 87 | 65 0.1
i 12 13 14 15
153 140|182 417 434 37 |55 -0
14 13 & i 7 i
68 | 157 137 | 127 87 | 43 0.4
& 7 g 9 10
7.0 6.3 | 75 54 |67 5.7 | 52 16 | 3. ~0.1
32 35 3 £ 15 3
76 | 65 55 | 4.3 St |8 0.6
1 2 3 4 5
p
fr-01 -02|-00 =01 |04 ~01 | 0.4 21|06 -0
e N 14 I = Fa
i =

~01  -01 |05 05 | 0.7 07|05 05 |02 0.2
21 22 23 24 25
75,4 5 | 7,7 77 | 40 40 [ 1.3 i@
2 5 7 8 3 3
209 209 52 | 8.5 85 | 4.8 48 | 16 1.6
16 17 18 19 20
749 24, 5.2 | 82 82 | 26 2.6
2 19 : 3 4
231 & | 14 8.4 84 |27 57
11 12 13 14 15
466 46,6 265 20,5 | 1, 1.3 | 36 36
14 +3 15 15 17 12
436 436 197 197 |12 12|56 3.6
6 7 ! 9 10
503 503 255 253 | 42 4.2
32 36 5 8 19 1
488 488 28 228 4.2 4.2
. i 2 3 4 5
T
] 51.0 240 240 | 44 44

Fig.4 Results of FEM analysis: Inner shear force¥y — Direct values in element nodes (ULS)
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Concluding notes on inner forces

(1) Due to system symmetry, the inner bending mastapandm, are mutually exchangeable when rotated
by 90° in the plate plane. However, due to “nunarpollution” of the FEM approximatiomm, andm,
are not exactly equal at central node 2, since betgng to the inner element node. However, in the
output mode “mean values in mesh nodes” the symymigtmaintained, since here all adjacent inner
nodes contribute.

(2) The statement of (1) is true also for the insleear forces, andv,. However, since shear force is an
“anti-symmetrical” quantity, the sign can change.

(3) A comparison of Fig.2 and 3 confirms the welblyn fact that the intensity of bending in the certnd
in the corner of a (simply supported) quadratidepla of about the same quantity. There may badou
other ratios when looking for tabled values inrbtere, but the differences are due to differeatepl
solutions applied.

(4) The shear force, in Fig.4 is not the&irchoffs combined “shear reactionV{+ om,/ct); thus,v, — 0 in
the corner(s). By fixing the radial rotation of thess-section perpendiculars, as it is obviousftbe
boundary conditions representation in Fig.1, theibm moment singular effects upon the functiothef
tangential shear forog along the edgesy(— along the edges= const;v, — alongx = const), have been
eliminated from the FEM solution. Thus, neithes thell-knownKirchhoffs singular corner forc® is
not explicitly present in the model. Refer to fb} detailed description of this phenomenon, having
already caused so many irritations on the hotline.

C. ULS Design — Statically required reinforcement

In this Chapter, pure stat. required reinforcemeist dealt with by the variant project
Plate_Benchmark_EN(O) To disable the determination of the minimum reegiireinforcement, which
might superpose the statically required valuessjiscification is suppressed on input for purpdsthis
Chapter. As shown in Fig.5, the control optionsiriivhum tension reinforcement” are unchecked fohbot
faces. The options “Minimum transverse reinforcetheind “Maximum degree of reinforcement” are
important control values defaulted to the Normudtitions. The non-standard option “Maximum peragat
in pressure bending zone”, which limits the amoafntompression reinforcement (see Chapter A), eéslat
the resisting force in the compression reinforcententhe concrete force activated in the compressio
bending zone of concrete cross-section. Thdefault value of 50% is borrowed from SIA 162,8B16;
EN 1992-1-1:2004 does not stipulate this kind afitoa! See also the alternative control as descrilm
Chapter D, Fig.12.

[x]

Diesign defaults
Gereral

# Caleulation
ULs

i Shear
SLS

2D members and beam-slabs

- Reinfarcement-—

‘- Oreep W Minimurm transverse reinfarcerment 20 O3
E'S[C)k proof I Mikimumn constructive reinforcement |1 %
Tk e v M auimium percentage in pressure ,50— %

: bending zahe
Wwharhings and ermors

Iinirmum kension reinforcement on face Zp+ S22
& Autamatic

@Minimum terision reinforcement on face Zp- 9.2 1.1
1 b tenson teinf peieftage i %
W Mawimum degres of ienforcement 14 4 82112
I Mirimurn shear reinforcement |d %

Fig.5 Input dialogue window — max/min tension reiforcement set inactive
The NEDIM design results will be scrutinized in @kin three element nodes, as marked in Fig.6 and

using the special numerical protocol of the NEDIMSsT Strategy:C.1 Elliptic stress design Case ;2
Hyperbolic stress state design Cas€ 3 Shear Proof Case 3.
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The specification data of the reinforcement andssigection geometry are defined in the input window
“Data slab concrete” as shown in Fig.6. For thkiaraple, identical orthogonal reinforcement at Hattes is
specified. The outer reinforcement courses go [ehtalX,, whereas the inner courses are parall&t,toAll
reinforcement bar diameters age 10 mm; the concrete cover és= 30 mm, the bars crossing in contact.
These data are necessary from begin with to edithatstatic heights of individual reinforcementises.

E Basic data -~
du Type of reinforcement gearnetry Orthogonal :_]
user defined __v__]
l EI Different layers per side
= = = Lo User reinfarcament [m]
User input thickness a
- 57| | Main reinforcement steel | B E0OC .l
Shear reinforcement steel | B 500C LLJ
2L itudinal
® jl First direction angle [deg] 0.00 =
£ Mumber of reinforcement layers 2 Av‘_l
di =i :
Diameter [duad) [mr] =
Laver angle 0.000 Alpha1 =0° L‘
- Concrete cover [cu,cl] [mm] @
ce del EIF
CQI ’CE Criameter [du.dl) [mm] Albha2=90 _:_]
1 [ ] —i—— Layer angle 900 P
Type of cover layer on previous laper I..l
Concrete cover [mmm] A0 e
Load default values )
Concrete Setup |
i

Fig.6 Concrete data input window — reinforcement ad cross-section geometry

The reinforcement courses pertaining & +Z, are distinguished by the indices +/—. The natarder of
courses at a face is marked by indices 1, 2 — frmnoutermost to innermost course within the cemsgion.
In the following numerical analysis, the first rmrcement courses will be discussed with no lossniver-

sality.

In Cases 1, 2, which deal with design fmion the diagonal symmetry axis, the reinforcement

amountsay andag, are approximately in the ratio of the correspogditatic heights [1].

| zo2 | 209 I3 29
71 92 23 25
385 | %29 ] 417 211
= = = =
447 | 3 aza | 3 : 207
16 17 18 20
430 | 435 479 | 441 338 | 408
; = : = 4
423 455 | 393 444 | 402 398
i 12 13 15
414 | 401 452 | 449 447 | 456 423
= 5 H L 1
435 465 | 414 453 | 422 403
& 7 2 10
21 432 | 418 457 | 459 460
26 = = b 1
216 447 | 396 469 | 433 448
1 2 3 5
195 405 | 3 455 | 435
1 A 1 G Zl
4 . -4 4

Fig.7 Design results: stat. required reinforcemen@e. [mm2/m] —

(ULS)
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s 196 58 0
21 22 23 24 25
0|20 00
2 = 7 = 4 3
394 : 0| 22 010 0
16 17 18 19 20
y 0|0 0|0 0o 0
2 19 . 3 .
17 0|28 010 010 0
M 12 13 14 15
191 0|33 0|0 00 00 0
14 13 15 16 17 9
26 | 72 0|0 0|0 010 0
8 7 g 9 10
0|0 0|0 00 0o 0
37 36 & & = 3
00 0|0 010 010 0
1 2 3 4 5
Iras ofo ofo 0fo oo 0
){ ':1 & —1 Fea

Fig.8 Design results: stat. required reinforcemen@g+ [mm2/m] — Direct values in element nodes
(ULS)

C.1 Design Case 1: Statically Required Reinforceme— Elliptic Tension

As seen from Fig.2,3, in element 5, inner node d@n(dent with the FE mesh node 2) both bending
moments are positiven,>m,>0, i.e. tension at the lower fac&;- The torsion moment,, tends to zero;
however, the theoretically exact zero value is ftged” by the FEM approximation. Thus, an ellipsiiate

of stress with tension at fac&sis to examine in this design point. From Fig.2,3 dnel Test Strategy
protocol, the following Table 1 has been set up.gtaphic representation is given by Fig.9.

Table 1 Inner moments [KNm/m] (Basic/ Principal/ Desighin element 5, node ZTest Strategy line 1#)

my m, myy m my o, Mgy My Mgy
39.3 39.3 -0.4 40.0 38.6 -45.0° 40.0 40.0 -1.4
@ Y ® Y © v
m|=+393 m, =-04 M =14 M,y =+ 40.0
m, =+B9.3 /\ «,=-45,0° &
‘ Y
m,, =-0.4 m, =+ 38.6 m, =+ 40.0 myy = l"‘ 40.0

Fig.9 Graphic representation of Table I(elliptic inner moment transformation, facg,)-
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The generalized invariant relation (5) in [1] isisked:
Mg+ Moy + Mg =40.0 + 40.0 - 1.4 78.60 = m; + m; =40.0 + 38.6= 78.60 [KN/m] D

The design momentsr;g, Myq, Meg} May be, in analogy to mathematic terminology, sidered aseparated
result valuesof the 2D design problem, which thus disintegrates three individual pseudo 1D design
cases. With the inner forces levels (fPlate design model enables exact distinguishing of oeggment
courses):

Z=¢meanX h; 2)
h;=h—c—@/2=0.250-0.030-0.010/2=0.215 [m], h,=h;—=0.215-0.010= 0.205 [M], {near= 0.96514 [-]
2,=0.96514x0.215 = 0.207512,=0.96514x 0.205 = 0.19785 [m]

The required reinforcement amount is then calcdlégemally as in two mutually independent 1D mensber
Asireq= Mig/ (fya X ) (3
As1.req= Mg/ (fya X 219) = 0.040(500/1.15%0.20751) = 4.43—4 [m?/m] =443[mm?/m] (not displayed here)
As2 req=Mpa/ (fya X Zog) = 0.040(500/1.15%0.19785) = 4.65—4 [m?/m] =465[mm?/m](agreement with Fig.7)

The virtual concrete strut, which function may Heamacterised as “stiffening of the reinforcement ne
against distortion in its plane” is checked as “poession concrete zone without compression
reinforcement” [1]. The strut check is governedly formula:

§strut < é:lim ['] (4)

where &, is the limit value of the relative bending zonedhej & is the actual relative height of the
bending zone under the impactraf. With the £' default values of the reduction factgg=0.80 (i.e. 80%
of full design strength of concrete, weakened maltel cracks, is applied) and the limit value log trelative
bending zone heiglit,,= 0.450 (Fig.10), the following relation is met:

Ssru=0.012< 0450

There is a substantial resistance reserve in #agyd point; (to be expected, sinog — 0 (double symmetry)).

 Seiug 92.3. %]
Design defaults
General
B C=lculation - General
uLs M umber of iberation steps 100
Shear -
cLS Frecision of iteration 1 %
- Creep Lirnit »alue Far checks 1
Crack proaf Far stiffness, allowable stress, punching and crack-proof calculation use
- COD reinforcement

Detailing provizionsz
‘Wamings and erors

|In order: [ Az, uger]; [ Aztot or 0] _vJ

[ Check selected sections only

[~ Concrete area weakened by reinforcement bars

[~ Concrete area weakened by prestressed reinforcement

¥ Take into account long.user reinfor. for design cale,

[ Check shear of construction joint

[ Check the interaction of shear, torsion, flexure and axial load

- Lirnit Biending pressure 2one rabio sud - (35050301
for C12/C15 till C50/CED 0.45 |

far concrete claszes higher than C50/C60 035

2D structures

W §9.3201) req shear ieinforcement -» ¢z height >= 20 cm

[ Diesign of pressure reinforcement in plates

- 2D user reinforcement -

I Check of concrete cover for subtracting 20 user reinforcement
from required reinforcement,

Dielta Jo h
Special design control - =
Wirtual etrut strength reduction factor 180 b4

Fig.10 Concrete Setup - limit value of the relatie bending zone height and strength reduction factor
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C.2 Design Case 2: Statically Required Reinforcemé— Hyperbolic Stress

As seen from Fig.2,3, in element 21, inner nodecdinCident with the FE mesh node 21), the bending
momentsm, andm, tend towards zero while the torsion moment attamsntensity level comparable with
the bending moments in element 5. This is a typigglerbolic state of stress, as the altering safnihe
principal momentsn > 0 andm, < 0 demonstrate — see Table 2. The graphic reptason is given by
Fig.11.

Table 2 Inner moments [KNm/m] (Basic/ Principal/ Desighin element 21, node 4Test Strategy line 2#)

my m, My my my a1 My My Mgy

2.7 2.7 -33.1 35.9 -30.4 -45.0° 35.9 35.9 -66.

1A°)

@ Y ® r+y ©

m.=}+27 || m,=-331 My =+ 35.9
+X

m, =+ 2.7 Il /\ o, =-45,0°

g my=-304] m=+359 M,y 4+ 359

Fig.11 Graphic representation of Table Zhyperbolic inner moments transformation, fa@g)+

The generalized invariant relation (5) [1] is Satid:
Mg+ Myg + My =35.9 +35.9-66.255 = m +m; =35.9 -30.4= 5.5 [KN/m] (5)

The most distinguishing difference of the invariaglations (1) and (5) is that of the intensitydewf the
design momenteg: in the elliptic stress case (1), it is a valuediag to zero; in the hyperbolic stress case
(5), it is a significant quantity, here absolutalgout twice as high as the sum of absolute valfigheo
principal moments. This is characteristic a phenmmnefor the hyperbolic cases: the stiffening fumectof
the concrete, the virtual strut, becomes the crtatdor of the designability.

Analogously to the elliptic Case 1, the requiredhficrcement in both directions at fac&,tis calculated as
follows:

h;=0.215 [m], h,=0.205 [M], {mear= 0.96514 [-]
2,=0.93936x0.215 = 0.201962,=0. 93936x 0.205 = 0.19257 [m]

The required reinforcement amount is then calcdl&gemally as in two mutually independent 1D mensber
As14req= Mg/ (fyax z14) = 0.0359(500/1.15% 0. 20196) = 4.08-4 [m?/m] =408 [mm?/m](not displayed here)
As2+req=Mpa/ (fya* Zog) = 0.0359(500/1.15% 0. 19257) = 4.28-4 [m?/m] =428 [mm?/m](agreement with Fig.8)

The virtual concrete strut is checked by the refa{i):

Cstrut=0.204< 0450
Thus, there is still a resistance reserve of thieali strut in this hyperbolic state of stress.

Hint: the procedure of checking the virtual strut bagricapacity is a very distinguishing feat of
SEN/NEDIM, which hardly any competing software caois@s. The topic of checking the stiffening funatio
of concrete in bent continua has been dealt witome detail in [2].
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C.3 Design Case 3: Shear Proof

Some features of the SEN/NEDIM Shear Proof procedull be demonstrated on element 1, inner node 1
(coincident with the FE mesh node 1). Fig.4 digplaere the maximum value wf As seen from Fig.2,3,
the bending stress tends here towards zero, whkich plausible result. From the Test Strategy 8#e
document, the following relations can be estabishe

W =51.0,,=—0.2 [KN/m],fo = 0.2 [] — Veq=51.0 [KN/m]

The “theoretical” values arer, =0, S, = 0. Since there are no accidental load cases smbcihe material
partial security coefficients arng = 1.15 andy. = 1.50, thusf,y = 434.8 andf,q = 13.33 [MPa]. The shear
resistance without shear reinforcement accordirgbtd.2 (6.2a) is estimated as

Vrdc=91.3> Vgq [kN/m]

Thus, no shear reinforcement is required in thEgiepoint, and nowhere in the model, since hezentbst
critical design situation appeatrs.

C.4 Alternative Design Cases 1+2: Reinforcement @metry (0°/60°/120°) and (—135°/45°)

Numerical results and screen copies of this Paphgravere obtained by the project
Plate_Benchmark_EN(1)

To demonstrate the distinguishing features of thed2sign module SEN NEDIM, the use of a 3-course
reinforcement net is presented and briefly disaliskeengineering practice, ~95% of design caspesent
the elementary arrangement of orthogonal reinfoese¢mvith congruent nets at face®,#+Z,, the outer
course parallel tX;, the inner course parallel ¥ — as if it were a “nature law”. NEDIM offers, hewer,
general reinforcement arrangements — combiningdifft specifications of orthogonal, skew angulaB-or
course reinforcement, respectively, at both facklere we will discuss some features of a “nonstahda
design”, using the reinforcement nets (0°/60°/12@fpce —g and (—135°/45°) at face $Z

(This Paragraph C.4 will be completed in Releasétdis Benchmark document)

D. Required Minimum Reinforcement
Numerical results and screen copies of this Chapéee obtained by the projeetate_ Benchmark EN(2)

In this Chapter, the effect of activated minimumsien reinforcement specification according to NEDI*
default input, as shown in Fig.12, is dealt witls. &fact, the user may modify the settings, buéjgiteg the
1* default, legal solution according to the Norm ligained.

s

&4l
AR

Dezign defaults
General

* Caloulation
ULS

* Shear
5LS

20 members and beam-slabs

— Reinforcement

- Creep b Mirimun transverss reinforcemient ]20— %9313
E[S';k proct ™ Mirimum constiuctive reinfarcemernt I— 2

Dietailing provizions ¥ E‘l;::cillgl:]ugrlop:;centage WiHesre ]50— %

HanRER AL ?@Winimum terizion reinfarcement 0 321311

& Automatic caleulation of minimurn bension reinforcerment

1 Minterision reinf percentage %
@vﬁnimum terision reinforcement 0 2111}

f* Automatic caloulation of mininum tersion rsinforcemett

" Min tension reinf percentage r 4
v Masimur degree of reinforcement 4 Z 821102

T Minimurn shear reinforcement B x

Fig.12 Input dialogue window — max/min tension reiforcement set active
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The choice of the “Automatic calculation of minimuension reinforcement” ensures the consideratfon o
the EN provisions to prevent so calledktle fracture according to §9.2.1.1(1) (9.1N). The alternativ¢his
option is the input of percentage which will be sygmwsed in each point to required tension reinford;

this is non-standard control under EN 1992-1-1:2008e control option “Maximum percentage in pressu
bending zone” serves to limit the amount of regliicempression reinforcement to the given percentage
related to the pressure bending zone force; théetault of 50% limits thus the steel force to 50%the
concrete force. In this example, however, thisiaoptis without practical impact since there is no
compression reinforcement required.

From the relation §9.2.1.1(1) (9.1N) the followiftgmula for 2D calculation of the minimum reinforoent
against brittle fracture follows:

Asymin = Max(0.26fm/fy, 0.0013xd  [m2/m] (6)
With d; =0.215 mfim=2.20 and,,=500 NEDIM estimates
as,min=mMax(0.001140.0013)x 0.215x 10° = 279.5 [mm?/m]

We find the value of 280 mm?/m in the display a# thnctionsag.,reqmin @Nd&g+req+min IN Fig.13 and 14. All
values 280 in the reinforcement display (markeghaiize that the pure statically required tensginforce-
ment is less than this minimum value. This canaliglbe checked in comparison with Fig.7,8.

21 22 23 24 25
395 | 479 384 | 417
2 5 7 = g 3
447 o dd
18 17 18 19 20
P
430 | 435 475 | 441 158 | 408
2 19 24 CE 3 '
423 455 | 393 444 | 402
11 12 13 14 15
414 | am 452 | 449 447 | 458 423
14 1z 15 15 17 18
435 465 | 414 453 | 422
& 7 ) g 10
f'__\
432 | 419 457 | 459 460
32 26 & = 1 42
447 | 306 469 | 433 448
1 2 - 4 &
.’\ '|
o 405 | 3 455 | 438 485
A==t N _14_' c: —] Pat =
P—miat%: Tk =

Fig.13 Reinforcement@g. req+min [MM?/m] — Direct values in nodes
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£l a2 i -
428 376 ( ] 0
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( 0 ] olo 0
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394 l 0 J 0|0 0
16 17 18 19 20
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0|0 g0 ala 0
7 Ee! 4 ' 23 4
0 0|0 0|0 0
1 12 13 14 15
Y
o oo g | olo 0
1 1= 15 16 17 18
0lo alo 0|0 0
i g g 10
o0 0|0 g|o oglo
32 36 & C 19 12
oo glo g|o al|o 0
1 2 z 4 5
& | o oo g0 0|0 0
a&\/ E [ —i Pt =
Py #:% T

Fig.14 Reinforcement@g+ req+min [MM?/m] — direct values in element nodes

E. SLS Design — Reinforcement Augmented to Limit Gick Widths

Numerical results and screen copies of this Chapéee obtained by the projeletate_ Benchmark _EN(2)
(continued from Chapter D).

In this Chapter, the effect of activated minimumstien reinforcement specification according to NEB
1* default input, as shown in Fig.12, is dealt witls.a fact, the user may modify the settings, buepting
the default value, a legal solution according ®Nworm stipulations will be obtained.

The declared task of the Crack Proof (particulaiiythe 2D design) is checking the crack widths lin a
design points according the stipulations of EN 12922004, 87.3.4 “Calculation of crack widths” and
augmenting the reinforcement delivered via thelzieta from the ULS phase so as to meet the condition

Weal S Wi (6)

with wgy — the actual crack width calculated from the folan&i7.3.4, (7.8). As a fact, SEN/NEDIM seeks
the value fulfilling the equality in (6) by a sopticated (sub-linearly controlled) iteration praseBhe result
is the reinforcement amoual, ;, s+s swhich meets the requirements of both ULS and Sessgth phases:

A2 ULS+SLS2 As2 req+minz B2 req (7)

(compare with Fig.16,17 and Tab.3,4). In the CrRotof algorithm not only the bar diametggdut also
the specified bar distances (Fig.15) play a crucial role: they represent thgeris decision to use
reinforcement bars of this diameter, spaced at maxi by the distance specified. Thus, the final
reinforcement amourds . s+s srespects this restriction as a kind of “overall imuam reinforcement”. In
this example, the reinforcement amount correspgnttiy= 10/s= 200 (Fig.6,15)— &s min const= 393 mmz/m
will be encountered at several design points, bpfter and lower reinforcement — as marked in Fi§.216
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Design defaults
General
* Calculation

Detailing provisions
W arnings and errors

Crack praof

- General
kt - lnad duration factar according 57.3.4(2)

[ 0.4 for lang termn loads; 0.6 for shart term loads ]

T

— 2D structures

{ Limit bar distances

bar distance on face Zp ¢ on face Zp- C@
e i

Ir percent of fot

[ Cancrete tension strength fct.eff in early stage of hardening

100 b4 ‘

Fig.15 Concrete setup window — maximum allowablesinforcement bars distances
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Fig.16 Reinforcement@s,. yLs+sLs[mm?2/m] — Direct values in nodes
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A 4 Z i =
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Fig.17 Reinforcement@Bs+ ys+siL.s[mm2/m] — direct values in element nodes

Following Tables 3,4 compare the reinforcementgiexi at the three design stages discussed aBmee.
marks the stag®inimumandRedmarks the stag€rack Proof— when the reinforcement amount obtained
here is higher than in the previous design stagé(dy reinforcement values,. (direction 90°) presented in
the following tables are shown above. All of thean be checked by viewing the display data of the
projects (0) to (2).

Table 3. Comparison of the reinforcement stages) design points 5/2, 21/4 and 1/1 ~ Lower face

Reinforcement at fac&s ~ ag - Reinforcement at fac&s ~ ax -
Elem/Node [mm?/m] [mm2/m]
Ag-req As1-reg+min Ag1- ULS+SLS A req Ag2- reg+min Ag-ULS+SLS
5/2 443 443 443 465 465 519
21/4 344 344 393 361 361 439
1/1 28 280 393 0 0 0

Table 4. Comparison of the reinforcement stages design points 5/2, 21/4 and 1/1 ~ Upper face

Reinforcement at facez ~ ag.

Reinforcement at facezZs ~ agp.

Elem/Node DL TG
As1+req As1+ req+min As1+ ULS+SLS A+ req A2+ req+min A2+ ULS+SLS
5/2 0 0 0 0 0 0
21/4 408 408 408 428 428 486
1/1 0 0 0 35 280 393
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The examination of Tables 3,4 enables the follovdoclusions, which possess general validity:

(1) Pronounced values of statically required raicément are typically “resistant” to augmentatigmtini-
mum reinforcement or Crack Proof requirements;

(2) Either the minimum reinforcement or Crack Proefluirements may yield higher reinforcement; the
superposition result represents always the higirasunt;

(3) If the statically required reinforcement amoimtero, the application of the minimum reinforegrnor
Crack Proof requirements has no impact upon itsnemging; the SEN/NEDIM result valugy s.s sre-
mains zero! This may sometimes be found surpridimgt irritating: it is, however, not the task of
SCIA software to present non-existing results. Heeve the user is not obliged to apply zero
reinforcement where he will use a honzero reinforeet constructively.

(4) FEM is an approximate (numerical) method ofvieg differential mechanical problems. The results
(inner forces) aremean values on elemeand represent basically non-continuous functidrsus,
“unexplainable” reinforcement values, as compardth Wtheoretical” values of other (analytical)
solutions or models, are hardly erroneous; theytrale counterparts of the inner forces, which asedu
by NEDIM without any biasing “adaptations” [3]. &rdesign point in element 1, node 1 is a typical
example of these relations: “theoretically”, altednforcement values are zero, but this is never in a
FEM model. Thus, we have gat. = ax_= 0 (as expected), baty., ag- > 0 — due to the “numerical
polution” of the FEM solution.
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